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Introduccidn

Introduccion

Harmony es un software de animacién completo que permite crear todo tipo de proyectos de animacién
creativos. Incluye una gran variedad de herramientas y funciones.

En esta Guia de introduccidn, aprenderd los conceptos bdsicos del uso de las principales funciones de Harmony
Advanced, y que le permitirdn ponerse al dfa rdpidamente. Consulte la documentacién completa de Toon Boom
Harmony disponible en linea en docs.toonboom.com para aprender acerca de todas las herramientasy

opciones, asi como sobre las técnicas avanzadas.


http://docs.toonboom.com/
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Capitulo 2: Creacién de una escena

Capitulo 2: Creaciéon de una escena

Al iniciar Harmony, aparece la pantalla de bienvenida, desde donde puede:
o Crear escenas
« Seleccionar la resolucién de la nueva escena
« Administrar los valores predeterminados de la resolucion de la escena
« Abrir rdpidamente escenas recién abiertas
o Examinary abrir una escena creada
« Ver tutoriales en video de Harmony en la web

« Acceder ala pdgina web de soporte

@ Harmony

Abrir una escena
reciente

Creary
nombrar una
escena

Crear o eliminar
unwvalor
predefinido de
resolucion de
una escena

Seleccionarla
resolucién dela
escena

ch Video Tutorials - Get Help Examinary

Open... abriruna
escena

Acceder a la documentacién
de Harmony

\er tutoriales en
video de Harmony

NOTA

Si estd usando Harmony Server, debe utilizar la aplicacién @ Centro de control para crear escenas
antes de que pueda abrirlas en Harmony. Las escenas de Harmony Server no se pueden crear
directamente en Harmony.
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Creacién de una escena desde la pantalla de bienvenida

1. En el campo Name (Nombre), escriba el nombre de la escena.

NOTA

El nombre de la escena no debe superar los 23 caracteres y no puede contener
caracteres especiales, como *&A%!.

2. Paradecidir en qué directorio se va a crear la escena, haga clic en el botén Browse (Examinar) junto
al campo Location (Ubicacidn).

4. Haga clic en Create Scene (Crear escena).

Se crea una nueva escena. La ventana de la aplicacién principal aparecerd con la nueva escena
abierta.
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Capitulo 3: Introduccidn a la interfaz de usuario de
Harmony

El uso de Toon Boom Harmony serd mucho mds facil si primero se familiariza con su interfaz de usuario. En este
capitulo se proporciona una introduccién bdsica a los elementos mas importantes de la interfaz de usuario. A
medida que avance de capitulo, obtendrd informacién mds detallada sobre cada uno de estos elementos.

Al iniciar Toon Boom Harmony por primera vez, se presenta el espacio de trabajo predeterminado. El espacio de
trabajo estd compuesto de barras de herramientas y paneles, denominados vistas, que permiten crear y editar
la escena. El espacio de trabajo predeterminado contiene las barras de herramientas y vistas mas utilizadas
para la animacién digital.

Vista de
propiedades
dela
herramienta

Barra de
herramientas de
herramientas

Vista de color

Vistade
cdmara

Barrade
herramientas de ;
L Vista de linea
reproduccién 3
de tiempo

Adicion de una vista al espacio de trabajo como una pestana

1. Enlaesquina superior derecha de una vista existente, haga clicen el botén 4 Add View (Agregar
vista).

10
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2. Seleccione la vista que desee en la lista.

La vista aparece como una nueva pestafia en la seccién del espacio de trabajo donde la agregé.

Tool Properties | Library = Layer Properties + (%

ma =

NOTA

Algunas vistas, como las de cdmara, perspectiva, libreria y modelo, se pueden abrir en varias
instancias. Por ejemplo, puede resultar (til si desea tener dos instancias de las vistas de cdmara
abiertas, cada una centrada en distintas dreas de la escena, para cambiar rdpidamente entre
los trabajos de estas dos dreas.

11
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Adicién de una vista al espacio de trabajo como una ventana

1. Abrael mend Windows (Ventanas).
2. En el mend Windows (Ventanas), seleccione la vista que desee agregar.

La vista aparecerd como una nueva ventana sobre la ventana de la aplicacién principal de Harmony.

Anclaje de una ventana de vista en el espacio de trabajo

1. Hagaclicy arrastre la vista flotante por la pestafa y realice una de las siguientes acciones:
o Coloque la ventana sobre otra pestafa para agregarla a ese conjunto de pestanas.

« Cologue la ventana por encima, por debajo o junto a una vista existente. Al acercarse al
borde de una vista, aparece un rectangulo cian que indica dénde se anclard la vista.

Vistas

Aqui se proporciona una breve introduccién a cada una de las vistas mas utilizadas en Harmony.

Vista de camara

La vista de cdmara es el centro de operaciones en Harmony. En esta vista puede dibujar, pintar, animar,
configurar la escena, manipular objetos, abrir simbolos y previsualizar la animacién.

La vista de cdmara también tiene una barra de herramientas superior e inferior que puede utilizar para navegar
en la vista, cambiar el modo de visualizacién o subir la jerarquia de simbolos.

12
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[ Jerarquia de simbolos l Barra de herramientas de cdmara

Valores
predefinidos de
herramienta

Capas de
dibujo

Modo de vista J| Modo de vista
de OpenGL J| de render

& W

Mesa de luz Nombre Nombre de

del dibujo | | herramienta

I Mend de zoom Color seleccionado

Ndmero de
fotograma

| Dibujo actual encima | [ Restablecer vista

| Mdscara de cdmara | [Trazar dibujos bloqueados ]

[ Zona segura “ Estilo seleccién BBox |

Vista de dibujo

En Harmony, puede dibujar tanto en la vista de dibujo y como en la de cdmara. Aunque las dos vistas son
similares, hay algunas diferencias cuando se trata de dibujar.

En la vista de dibujo solo se muestra el dibujo seleccionado de forma predeterminada. Puede utilizar funciones
como la mesa de luz para mostrar el dibujo actual de todas las capas habilitadas de la escena con colores
descoloridos, o el papel cebolla para mostrar los dibujos anteriores y siguientes de la capa de dibujo
seleccionada actualmente.

13
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| Barra de herramientas de vista de dibujo

Menu de vista

Camera Drawing =%

Valores
predefinidos de
herramienta

Capas de
dibujo

Area de
dibujo

| Selector de color I

Posicion
del cursor

Numero de
fotograma

Nombre del dibujo | | Nombre de herramienta

Vista de propiedades de la herramienta

La vista de propiedades de la herramienta contiene las opciones y operaciones mds comunes relacionadas con
la herramienta seleccionada actualmente. Al seleccionar una herramienta en la barra de herramientas de
herramientas, se actualiza la vista de propiedades de la herramienta.

Por ejemplo, si elige la herramienta Select (Seleccionar), la vista de propiedades de la herramienta mostrarad las
opciones y operaciones relacionadas con dicha herramienta, como Snap to Contour (Ajustar a contorno), Apply
to All Drawings (Aplicar a todos los dibujos), Flip Horizontal (Voltear en horizontal) y Flatten (Acoplar).

Posibles
opciones y 1
modos para la
herramienta
actual

Posibles
operaciones
para la 1
herramienta
actual

14
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Vista de color

La vista de color es donde se crean colores y paletas, y se importan paletas existentes en el proyecto. La vista de
color también es necesaria para dibujar, pintar y crear estilos de color.

| Bajar/subir paletal | Indicador de modo Editar lista de paletas? I

Vincular paleta | Mostrar paletas de colores I

| Quitar paleta I

Agregar paleta

| Mostrar paletas de textura de ldpiz I

Ment de vista de colorl | Mostrar todas las paletas I

Cilour 4= %

| Contraer/expandir lista de paletas

Indicador de modo
Editar lista de paletas

Lista de paletas

| Indicador de modo Editar paleta?

| Il |
4 % | £ Modo Editar paleta?

Indicador de modo

Editar paletal

| Agregar muestra de color

| Quitar muestra de color

Agregar textura

]

HREHE | RE L LHWRERE 1S

Muestra de color

—| Lista de muestras de colores

El botdn Edit Palette Mode (Modo Editar paleta) solo estd disponible en Harmony Server, Edit Palette Mode (Modo Editar paleta) siempre
estd habilitado en Harmony Stand Alone.

Vista de linea de tiempo

Para establecer el tiempo de la animacidn, trabajard principalmente con las vistas de linea de tiempo y de carta
de rodaje. Es muy (til familiarizarse con la vista de linea de tiempo, su funcionamiento y su interfaz.

La vista de linea de tiempo es la vista principal utilizada al ajustar el tiempo de los dibujos, agregar fotogramas
clave y ordenar capas. La vista de linea de tiempo muestra capas, efectos, sonidos, valores de fotogramas clave,
duracién de escena, nombres de capas, dibujos, fotogramas clave, tiempo y fotogramas.

15
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| Habilitar/deshabilitar capa |

(Habilitar/deshabilitar modo Solo | (Fore s
|Agregar.-fquitar papel cebolla | |Eliminar capa |

| Bloquear/desbloguear capa | |Agregar capa de dibujo |

| Alternar medo esbozo |

Agregar pe
Mosiarfoeultaring | ikl gll Cursor de linea Exposicidn
ostrarfocuiarimagenes ( Parametros | de tempo de dibuio Dividir vista
en miniatura

rnos=am

| Expandir/contraer grupec | Coordenadas en el
| Expandir/contraer jerarquia de capas | fotograma actual Zoom_de linea Fotog ks ,clave
de tiempo de funcidn

| Mostrarfocultar vinculos adicionales | Numero de dibujo

- en el fotograma
|Mostrar.-’ocultar parametros | Mostrarfocultar ctual &
. actual
funciones
|Ver modos I

La vista de linea de tiempo permite leer el tiempo de izquierda a derecha. Representa los elementos de la
escena en su forma mas simple. También puede ver las capas y sus nombres, asf como la exposicién del dibujo. El

nombre del dibujo se muestra al colocar el puntero sobre la exposicién del dibujo.

Vista de carta de rodaje

La vista de carta de rodaje permite leer el tiempo verticalmente mostrandolo en una cuadricula, con cada capa
de dibujo representada por una columna, cada fotograma de la escena representado por una fila y cada dibujo
expuesto mostrado por sunombre en las celdas. Se pretende que funcione como una carta de exposicién de
animacion tradicional.

Con el panel de funciones, también puede ver las funciones y los fotogramas clave de las rutas de movimiento
de la columna seleccionada, con el valor de esas funciones para cada fotograma que se muestra en las celdas.

16



Guia de introduccién de Harmony 16.0 Advanced

A diferencia de la vista de linea de tiempo, la vista de carta de rodaje no muestra pegs, efectos o jerarquia de
capas. Por lo tanto, se optimiza para una animacidn tradicional y sin papel, mientras que la vista de linea de
tiempo se optimiza para una animacién digital o Cut-out.

Barra de herramientas
de carta de rodaje

| Encabezado de columna

Dibujo actual
Fotograma actual

| Exposicién de dibujo

>

Modo
Sobrescribir/insertar

Aumentar/reducir
exposicidn

Columna de
funcién

Numeros de fotograma Dibujo/elemento

actual

Vista de libreria

La vista de libreria se utiliza para almacenar elementos como animaciones, dibujos, fondos y modelos de
personajes para volver a utilizarlos en distintas escenas y proyectos. También puede utilizar la vista de libreria
para crear y almacenar simbolos, asi como para almacenar e importar imdgenes y archivos de sonido.

Para reutilizar elementos de una escena en otras escenas, debe crear una plantilla para poder importarla en
distintas escenas. Las plantillas pueden contener cualquier elemento, desde un solo dibujo hasta una estructura
de escena completa. Puede crear una plantilla en una escena y copiar los elementos que desee de la plantilla en
una libreria. La plantilla resultante se estructura como una miniescena que solo contiene los elementos que copid
en ella. Una plantilla no tiene ninguna dependencia sobre la escena en la que se creé originalmente. Por lo
tanto, se puede importar de forma segura en cualquier otra escena.

Ademads, el panel Drawing Substitution (Sustitucidn de dibujo) de la vista de libreria permite cambiar
rapidamente la exposicién del fotograma actual a uno de los dibujos existentes en una capa. Esto es
especialmente Util para la animacién de las bocas, manos, parpados y otras partes del cuerpo de un personaje
Cut-out que suelen contener varios dibujos para elegir.

17
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Lista de recursos

Vista previa de
imagen en miniatura

| Nombre del dibujo !

[ TTAT

| Nombre del elemento/recurso

| Control deslizante de fotograma/dibujo

| Barra de blsqueda

| Lista de carpetas de libreria

| 1Bl campo del nombre del dibujo solo aparece si se selecciona un elemento de la escena.

Interfaz de navegacion

Toon Boom Harmony permite acercar, alejar, rotar, panear y restablecer vistas para navegar facilmente por la
interfaz.

Los comandos de navegacion de la tabla que se muestra a continuacidn se pueden utilizar en las siguientes
vistas, con algunas excepciones:

e Cdmara

o Dibujo

o Perspectiva

e Lineadetiempo
o Carta derodaje
« Funcién

o Lateral y superior

« Modelo

Comando Accién Métodos de acceso
View > Zoom In (Ver > Acercar)
Pulse 2

Zoom In (Acercar) Acerca la vista. . ; . .
Gire la rueda del ratén hacia arriba
(excepto en las vistas de linea de tiempo
y de carta de rodaje)

18
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Comando

Accién

Métodos de acceso

Zoom Out (Alejar)

Aleja la vista.

View > Zoom Out (Ver > Alegjar)
Pulse 1

Gire la rueda del ratén hacia abajo
(excepto en las vistas de linea de tiempo
y de carta de rodaje)

Acercar o alejar

Acerca o aleja la vista.

Gire la rueda central del ratén hacia
arriba o hacia abajo.

Mantenga pulsada la barra espaciadora y
la rueda central del ratén mientras
arrastra el ratén hacia arriba o hacia
abajo.

Pan (Panear)

Mueve la vista horizontal o verticalmente.

Mantenga pulsada la barra espaciadoray
arrastre en la direccién que desee panear
la vista.

Reset Pan
(Restablecer
paneo)

Restablece el paneo de vista a su posicion
predeterminada.

View > Reset Pan (Ver > Restablecer
paneo)

Pulse Mayus + N

Reset View
(Restablecer vista)

Restablece la vista a su posicién
predeterminada.

View > Reset View (Ver > Restablecer
vista)

Pulse Maylis + M

Reset Rotation
(Restablecer
rotacién)

Restablece la rotacidn de vista a su posicién
predeterminada.

View > Reset Rotation (Ver >
Restablecer rotacidn)

Pulse Mayus + X

Reset Zoom
(Restablecer zoom)

Restablece el zoom de vista a su posicién
predeterminada.

View > Reset Zoom (Ver > Restablecer
zoom)

Rotate View (Rotar
vista)

Rota la vista alaizquierda o ala derecha.

Mientras mantiene pulsadas las teclas
Ctrl + Alt (Windows/Linux) o Ctrl + &8
(mac0S), haga clic y arrastre el disco de
rotacién para rotarlo a la derecha o ala
izquierda.

19
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Comando

Accién

Métodos de acceso

3D Rotate View
(Rotar vista 3D)

Rota la vista en cualquier direccién. Esta
opcidn solo estd disponible en la vista de
perspectiva.

Mientras mantiene pulsado Ctrl + Mayls
(Windows/Linux) o &6 + maylsculas
(macOS), haga clic y arrastre la escena
para rotarla en cualquier direccién.

Rotate 30 CW Rota la vista de cdmara 30 grados a la View > Rotate View CW (Ver > Rotar 30
(Rotar 30 der.) derecha, como una mesa de animacion. derecha)

Rotate 30 CCW Rota la vista de cdmara 30 grados a la View > Rotate View CCW (Ver > Rotar
(Rotar 30 izq.) izquierda, como una mesa de animacidn. 30izq.)

Vista de espejo

Cambia temporalmente la vista de cdmara o
de dibujo en horizontal, lo que permite ver y
editar la ilustracién como si se estuviera
reflejando.

View > Mirror View (Ver > Espejo)

Toggle Quick
Close-up (Alternar
primer plano
rapido)

Multiplica inmediatamente el factor de zoom
de la vista por 4. Por ejemplo, si el factor de
zoom de la vista de cdmara se encuentra al
100 %, esto hara que alterne entre 400 % vy
100 %.

Mayls + Z

Toggle Full Screen
(Alternar pantalla
completa)

Pasa por los siguientes modos de
visualizacién:

o Normal Full-Screen (Pantalla
completa normal): la ventana
principal de la aplicacién se convierte
en pantalla completa.

« View Full-Screen (Ver pantalla
completa): la vista seleccionada se
convierte en pantalla completay
todas las demds vistas se contraen.

o Normal: |a ventana principal de la
aplicacidn se restaura a su tamarfio
original y las vistas contraidas se
expanden.

View > Toggle Full Screen (Ver >
Alternar pantalla completa)

Pulse Ctrl + F (Windows/Linux) o &8 + F
(mac0S)

20
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Interfaz tactil

Si estd trabajando con una pantalla tactil, un trackpad o una tableta que admita funcidn tactil, también puede
utilizar los gestos de dos dedos estdndar para el zoom, la rotacién y el paneo en las vistas de cdmara y dibujo.
Para poder hacer esto, primero debe habilitar la preferencia Support Gestures (Soporte de gestos).

Habilitacién del soporte de gestos

1. En el menu superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows/Linux) o Harmony
> Preferences (Harmony > Preferencias) (Mac OS X).

2. Abrala pestafa General.

3. Enlaseccidén Touch Interface (Interfaz tdactil), marque la casilla de verificacién Support Gestures
(Soporte de gestos).

4. Haga clicen OK (Aceptar).
5. Reinicie Harmony.

Ahora puede manipular las vistas de cdmara y de dibujo arrastrando dos dedos sobre la interfaz
tactil.

Uso de gestos

1. Enlavista de camara o de dibujo, presione con dos dedos situados a una distancia corta entre si.
2. Realice una de las siguientes acciones:

« Para panear la vista, arrastre los dos dedos en cualquier direccién, manteniéndolos a la misma
distancia uno del otro.

o Paraacercar el zoom, arrastre los dos dedos separando uno del otro.

21
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o Paraalejar el zoom, arrastre los dos dedos acercando uno al otro.

« Pararotar, arrastre los dos dedos haciendo una curva para que giren en la misma direccidn.

22
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Capitulo 3: Adicion de capas

Al igual que con la animacién tradicional, Harmony utiliza capas para mantener los elementos, como personajes,
fondos y props, separados unos de otros, lo que permite animarlos de forma independiente.

Al crear una nueva escena, la escena tendrd una capa predeterminada denominada Drawing (Dibujo) en la que
se puede comenzar a dibujar de inmediato.

Capa de dibujo
predeterminada

Las capas se pueden seleccionar y gestionar en la vista de linea de tiempo. Una escena puede tener tantas

capas como sea necesario. Cuando la escena tiene varias capas, las capas superiores de la lista aparecen sobre
las capas inferiores.

Tipos de capas de dibujo
Harmony admite dos tipos de capas de dibujo, cada una con sus propias ventajas y limitaciones:

« Vector Layers (Capas de vectores): los dibujos de vectores estdn formados por puntosy curvas que
componen los contornos de las formas de la ilustracidn, junto con el color o las texturas de relleno. Por lo
tanto, la ilustracién en capas de vectores se puede escalar y ampliar sin que pierda calidad, a menos que
contenga una textura.
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Al dibujar en una capa de vector, cada trazo de dibujo y cada linea de |dpiz es un objeto independiente
que se puede manipular por separado. Puede seleccionar trazos y, a continuacién, moverlasy
transformarlas, incluso si se aplicaron trazos de dibujo sobre ellas. Ademds, debido a que los trazos de
dibujo estan formadas por puntos y curvas, es posible editar su forma, lo que facilita las correcciones y los
cambios en la ilustracién.

« Bitmap Layers (Capas de mapa de bits): los dibujos de mapa de bits se componen de una cuadricula de
pixeles, que son puntos pequefios que tienen un solo color sdlido. Las herramientas de dibujo de mapa de
bits permiten colocar trazos de pincel en un Unico lienzo plano y ajustar la ilustracién pixel a pixel si es
necesario.

Al dibujar en una capa de mapa de bits, cada trazo estd compuesta en el lienzo, por lo que continda
siendo un dibujo Unico que solo se puede pintar o borrar, pero que no permite ajustar partes individuales.

Las ilustraciones de mapa de bits solo se pueden escalar o ampliar tanto como lo permita su densidad de
pixeles sin perder calidad de imagen. De forma predeterminada, la ilustracion de mapa de bits tiene una
densidad de pixeles del 100 %, que solo es suficiente para mostrar la ilustracién sin ampliarla o escalarla;
de lo contrario, Harmony debe generar nuevos pixeles en la ilustracidn, lo que puede hacer que se vea
borrosa o pixelada.

Por lo tanto, es posible que desee establecer la densidad de pixeles requerida para la ilustracién de mapa
de bits, en funcidn de si tendrd que ampliarla o escalarla, antes de comenzar a dibujar en una capa de
mapa de bits.

NOTA

Como las capas de vectores se pueden editar y escalar, se recomienda comenzar utilizando capas
de vectores mientras se familiariza con Harmony. La capa de dibujo predeterminada de una nueva
escena es una capa de vectores.

Capas de dibujo

De forma predeterminada, cada capa de un dibujo tiene dos capas de dibujo: la capa de lineas y la capa de color.
Puede utilizar estas capas para mantener separadas la capa de lineas y los colores de los dibujos.
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Capa de lineas Capa de color

A la derecha de la vista de cdmara y de dibujo, puede controlar en qué capa de dibujo estd trabajando y si solo
se muestran la capa de dibujo actual o ambas capas de dibujo.

Camera = Drawing (% Vista previa de todas

las capas de dibujo

Establecer la capa de
lineas como capa actual

Establecer la capa de
color como capa actual

De forma predeterminada, estd seleccionada la capa de linea. Por lo tanto, si comienza a dibujar de inmediato,
dibujard en la capa de linea de la capa de dibujo, a menos que seleccione primero la capa de color.

El uso de distintas capas de dibujo para la capa de lineas y la capa de color es completamente opcional. Si lo
desea, puede utilizar la capa de linea tanto para la capa de lineas como para la capa de color.

25



Capitulo 3: Adicién de capas

NOTA

También puede habilitar capas de dibujo adicionales: las capas superior y de fondo. La capa de
dibujo superior se suele utilizar para anotaciones y la capa de fondo se suele utilizar para esbozos
bdsicos. Para habilitarlas, compruebe la opcién Support Overlay and Underlay Arts (Admitir capas
superior y de fondo) de la pestafia Advanced (Avanzado) del cuadro de didlogo Preferences
(Preferencias), al que se puede acceder seleccionando Edit (Windows/Linux) o Harmony
Advanced (macOS) > Preferences (Edit (Windows/Linux) o Harmony Advanced (macOS) >
Preferencias) en el menu superior.

Cambio de nombre de capas

En una nueva escena, solo hay una capa creada de forma predeterminada, y se denomina Drawing (Dibujo). En
la animacidn tradicional, es comin nombrar a las capas de animacién con letras individuales (A, B, C, etc.) y las
capas de disefio con acrénimos (BG para fondo, OL para superposicidn, etc.). Asi, puede comenzar la escena
dando a la primera capa un nombre adecuado.

Cambio de nombre de una capa en la vista de linea de tiempo

1. Enlavista de linea de tiempo, haga doble clic en el nombre de la capa que desee cambiar.

ro=al
o

2. Escriba el nuevo nombre de la capa y pulse Intro/retorno.

La capa tiene un nuevo nombre.
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Adicion de capas

Adicion de un elemento de dibujo desde la vista de linea de tiempo

1. Enlavista de linea de tiempo, haga clicen el botén % Add Drawing Layer (Agregar capa de dibujo)
o pulse Ctrl + R (Windows/Linux) o & + R (macOS).

Aparece el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo).

Add and Close

2. En el campo Name (Nombre), escriba el nombre de la nueva capa.

2. Seleccione si desea que la capa Line Art (Lineas) sea Vector o Bitmap (Mapa de bits).
3. Seleccione si desea que la capa Colour Art (Color) sea Vector o Bitmap (Mapa de bits).
4. Realice una de las siguientes acciones:

« Haga clicen Add (Agregar) para crear esta capa, pero deje abierto el cuadro de didlogo para
poder crear mas capas.

» Hagaclicen Add and Close (Agregar y cerrar) para crear esta capay cerrar el cuadro de
didlogo.

Se agrega a la vista de linea de tiempo una nueva capa de dibujo.

Eliminacion de capas

Eliminacion de capas en la vista de linea de tiempo

1. En lavista de linea de tiempo, seleccione las capas que desea eliminar.
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NOTA

Puede seleccionar varias capas contiguas manteniendo pulsada la tecla Mayus, haciendo
clicen la primera capa que desee seleccionar y, a continuacién, en la dltima. También
puede seleccionar varias capas manteniendo pulsada la tecla Ctrl (Windows/Linux) o 36
(macOS) y haciendo clic en cada capa que desee seleccionar.

2. Realice una de las siguientes acciones:

o Enlabarrade herramientas de capa de la vista de linea de tiempo, haga clicen el botén =—
Delete Layers (Eliminar capas).

« Haga clic con el botdn derecho en la seleccidn y seleccione Delete (Eliminar).

Las capas seleccionadas se eliminan de la vista de linea de tiempo.

Cambio de orden de capas

Reorganizacién de capas en la vista de linea de tiempo

1. Enlavista de linea de tiempo, seleccione las capas que desea mover.

2. Hagaclicy arrastre la seleccidn, y realice una de las siguientes acciones:

« Cologue la seleccién entre dos capas para moverla entre ellas. Aparecera una linea
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cian entre las capas donde se movera la seleccidn.

o Coloque la seleccién en una capa para aplicar un rig de las capas seleccionadas como
hijas sobre esa capa.

o/
Agrupacion de capas
La agrupacién de capas permite mantener la estructura de la escena organizada.

Ademads, puede colocar varias capas dentro de un grupo vy, a continuacién, agregar un efecto en este grupo para
aplicarlo en todas las capas del mismo.

Agrupacion de capas en la vista de linea de tiempo

1. Enlavista de linea de tiempo, seleccione los elementos que desee agrupar.

rno=am
o
o

i)
i)

NOTA

Las capas que se encuentren entre las seleccionadas se agruparan con las capas
seleccionadas.
2. Realice una de las siguientes acciones:

« Haga clic con el botén derecho en las capas resaltadas y seleccione Group Selection
(Agrupar seleccidn).

o Pulse Ctrl + Mayus + G (Windows/Linux) o &8 + mayusculas + G (macQOS).
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Se agrega una nueva capa de grupo a la vista de linea de tiempo.

Si hace clicen el botén Expand Group (Expandir grupo), encontrard las capas agrupadas en rig
como hijos de la capa de grupo.

Ocultacion y visualizacion de capas

Puede ocultar capas temporalmente para que no desordenen la vista de cdmara mientras trabaja en otras
capas.

Ocultacién de una capa en la vista de linea de tiempo

1. Enlavista de linea de tiempo, a la izquierda de la capa que desea ocultar, haga clicen el botén (¢4
Disable Layer (Deshabilitar capa).

La capa se volverd invisible en la vista de cdmara.

2. Sidesea mostrar la capa, haga clicen el botén “ Enable Layer (Activar capa) para volver a
mostrarla.
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Bloqueo y desbloqueo de capas

Puede bloquear capas temporalmente. Las capas bloqueadas se pueden editar en la vista de linea de tiempo o
de carta de rodaje, pero no puede seleccionarlas, dibujarlas o manipularlas en la vista de cdmara. Esto puede ser
Gtil para evitar seleccionar o dibujar accidentalmente sobre los fondos, superposiciones, props o personajes con
los que no esté trabajando actualmente.

Bloqueo de una capa en la vista de linea de tiempo

1. Enlavista de linea de tiempo, a la izquierda de la capa que desea bloquear, haga clic en el botén fm
Lock (Bloquear).

Serd imposible seleccionar la capa o dibujar en ella en la vista de cdmara. El nombre de la capa
aparecerd en rojo en la vista de linea de tiempo.

2. Sidesea desbloquear la capa, haga clicen el botdn Unlock Layer (Desbloquear capa) para volver
a mostrarla.
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Capitulo 4: Cémo dibujar

Una vez iniciado Toon Boom Harmony y creada una escena, puede comenzar a dibujar de inmediato utilizando
la capa de dibujo predeterminada en la nueva escena.

Cémo dibujar

1. Realice una de las siguientes acciones:

o Enlabarrade herramientas de herramientas, seleccione la herramienta & Brush (Pincel) o
pulse Alt + B.

« Enlabarra de herramientas de herramientas, seleccione la herramienta # Pencil (Ldpiz) o
pulse Alt + /.

2. Enlavista de linea de tiempo o de carta de rodaje, haga clic en la primera celda de la capa de dibujo.

3. Para seleccionar un color, haga clic en el color que desee utilizar en la vista de color. Para obtener
mas informacidn sobre la creacidon y edicidn de colores, consulte Creacion o edicidon de muestras de

colores en la pdgina 42.
Colour =%

Scene Palettes

[ AW
E &

4. En lavista de dibujo o de cdmara, comience a dibujar.
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Ajuste de ilustracion

Harmony ofrece distintas maneras de ajustar los dibujos. Puede deshacer el dltimo trazo, borrar partes de un
dibujo, mover, transformar o eliminar trazos, y modificar los puntos y las curvas de los trazos.

NOTA

No puede manipular o modificar los trazos individuales del dibujo al dibujar en una capa de mapa de
bits; consulte Adicidn de capas en la pagina 23.

Cémo deshacer el ultimo trazo

1. Realice una de las siguientes acciones:
« En el menu superior, seleccione Edit > Undo (Editar > Deshacer).

o Pulse Ctrl + Z (Windows/Linux) o 3£ + Z (macOS).

Cémo borrar
1. En la barra de herramientas de herramientas, seleccione la herramienta & Eraser (Borrador) o

pulse Alt + E.

2. Enlavista de dibujo o de cdmara, dibuje un trazo sobre las partes del dibujo que desee borrar.

Manipulacién de los trazos del dibujo

1. Enlabarrade herramientas de herramientas, seleccione la herramienta R Select (Seleccionar) o
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pulse Alt + S.

2. Enlavista de cdmara o de dibujo, seleccione los trazos que desee editar realizando una de las
siguientes acciones:

o Hagaclicen un trazo para seleccionarla.

« Mantenga pulsada la tecla MayUs mientras hace clic en un trazo para agregarla ala
seleccidn.

« Dibuje un lazo alrededor de los trazos del dibujo para seleccionarlas simultdaneamente.
3. Realice una de las siguientes acciones para editar la seleccidn:

o Para cambiar la posicién, haga clic en el objeto de dibujo seleccionado y arrastre la
seleccién a una nueva drea.

NOTA

También puede realizar un desplazamiento pequefio de la seleccién con
las teclas de flecha y, para realizar un desplazamiento rapido, mantenga
pulsado MayUs y pulse las teclas de flecha.

« Pararotar, agarre el controlador de la caja de seleccién y rételo.
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©

« Paraescalar, tire o empuje en el punto de control superior, lateral, inferior o de esquina.
Mantenga pulsada la tecla Mayus para bloquear la proporcidn de la seleccién.

o Parasesgar, arrastre hacia los lados o arriba y abajo los lados o los segmentos superior
e inferior, entre los puntos de control.

o Paraeliminar, pulse Supr (Windows/Linux) o retroceso (macQS).

Edicién de las lineas

1. Realice una de las siguientes acciones:
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« Sidibujé con la herramienta Brush (Pincel), en la barra de herramientas de herramientas,
haga doble clicen % Contour Editor (Editor de contorno) y seleccione 2 Centerline Editor
(Editor de linea central) en el mend emergente, o pulse Alt + W.

« Sihadibujado con la herramienta Pencil (Lépiz), en la barra de herramientas de
herramientas, seleccione la herramienta % Contour Editor (Editor de contorno) o pulse Alt +

Q.

2. Enlavista de dibujo o de cdmara, haga clic en la forma, el contorno o la linea de lapiz que desee
editar cerca del drea que desee modificar.

Aparecen los puntos de control de la forma o de la linea.

/

3. Hagaclicen uno de los puntos para seleccionarlo.

Aparecen los controladores de la curva Bézier del punto, asi como los controladores de la curva
Bézier para los puntos circundantes.

SUGERENCIA

Puede seleccionar varios puntos dibujando un lazo alrededor de los mismos, o
manteniendo pulsado MayUs mientras hace clic en los puntos para agregarlos a la
seleccién. Puede utilizar Contour Editor (Editor de contorno) para escalar y rotar una
seleccién de varios puntos habilitando la opcién iy Show Contour Editor Control
(Mostrar control de editor de contorno) en la vista de propiedades de la herramienta.
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4. Realice una de las siguientes acciones:

« Para mover un punto o una seleccién de varios puntos, haga clicy arrastrelo.

o Para cambiar la curva en ambos lados de un punto, arrastre uno de sus controladores de
curva Bézier.

o Para cambiar la curva en un solo lado de un punto, mantenga pulsada la tecla Alty, a
continuacidn, arrastre uno de sus controladores de curva Bézier.

« Paradeformar el contorno, arrastre una parte del contorno entre dos puntos.
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« Para deformar la curva entre dos puntos, mantenga pulsada la tecla MayUs y arrastre el
contorno entre dos puntos.

o Paraeliminar los controladores de curva Bézier de un punto y hacer que las lineas a las que
estd conectado sean rectas, mantenga pulsada la tecla Alt y haga clic en el punto.

VA

o Laslineasrectas no tienen controladores de curva Bézier en sus puntos de forma
predeterminada. Para crear controladores de curva Bézier para estos puntos y hacer que sus
lineas sean curvas, mantenga pulsada la tecla Alt y, a continuacién, haga clicy mantenga
pulsado el puntoy arrastre el cursor del ratén lejos de él. Un nuevo controlador de curva
Bézier seguird el cursor del ratén hasta que suelte el botdn del ratén.
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« Paraagregar un punto de control, pulse Ctrl (Windows/Linux) o & (macOS) y haga clicen el
contorno donde desea que se cree el nuevo punto.

o Paraeliminar un punto de control, seleccione el punto de control y pulse Supr
(Windows/Linux) o retroceso (macQOS).
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Capitulo 5: Cémo pintar

Toon Boom Harmony Incluye algunas funciones de pintura muy Utiles para agregar color a los dibujos. Mientras
que otro software solo permite que los usuarios trabajen con muestras de color de una en una, la pintura en
Harmony se realiza con paletas que contienen varias muestras de color que se pueden almacenar y reutilizar
segun sea necesario.

JHRONOROANNOO0NY

En la vista de color, seleccione una muestra de color distinta para cada color que desee pintar en el dibujo.
Puede agregar todas las muestras de color que desee. También puede cambiar el nombre a las existentes y
modificarlas.

INOOAO00NN
HORR0OgID

Cuando modifique el color de una muestra existente, se actualizaran automaticamente todas las zonas pintadas
con esta muestra en toda la escena. La muestra de color tiene un nimero de ID exclusivo que la asocia con las
zonas pintadas. De este modo, puede cambiar el aspecto del personaje en cualquier momento sin necesidad de
volver a pintarlo.
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Otra ventaja de este sistema es que puede crear paletas completas para distintas situaciones de luz. Por
ejemplo, ademds de la paleta habitual para un personaje, también puede tener una para ese personaje en la
lluvia con colores mds apagados y menos vivos que los colores de dfas secos, o incluso otra para una escena de
noche. De este modo, el uso de paletas vinculadas a un personaje permite cambiar el color al instante para
ajustarse al clima y al ambiente de la escena sin necesidad de volver a pintar cada elemento.

Paletas de colores

En animacidn se utilizan colores especificos para pintar cada parte de cada personaje. Con el fin de mantener
una coherencia absoluta, se debe crear una paleta de colores base para cada personaje, prop y efecto de la
produccidn. A esto se le denomina paleta maestra.

Las paletas maestras contienen una muestra de color para cada drea que se deba colorear. Cada muestra
almacena un color de niveles precisos de rojo, verde, azul y opacidad (a este Ultimo se le denomina alfa).

El uso de una paleta de colores maestra tiene muchas ventajas, entre otras:
« Cada personaje conserva permanentemente sus colores especificos.
« No puede usar por error un color que no esté en la paleta maestra.
« Estandarizacion y uniformidad del color durante la produccidn.
o Varios artistas pueden usar la misma paleta de colores y generar los mismos resultados.

Harmony utiliza paletas para mantener todos los colores necesarios para pintar los elementos, lo que permite un
control y uniformidad totales del proceso de pintado.

Una paleta se crea asignando un conjunto de colores a cada personaje, prop o efecto. Creard una nueva paletay
agregarda un nuevo color, conocido como muestra de color, para cada zona del personaje, como la piel, el pelo, la
lengua, la camiseta, los pantalones, etc.

Creacion de una nueva paleta

1. En el menu de vista de color, seleccione Palettes > New (Paletas > Nueva) o haga clic en el botén
New Palette (Nueva paleta)

Se abre el cuadro de didlogo Create Palette (Crear paleta).

2. Introduzca el nombre de la paleta seguin el modelo.

Ne ette Name:

Palette Typ

3. Hagaclicen OK (Aceptar).

La paleta aparece en la lista de paletas.
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Colour =%

Eallhdl

Creacidn o edicion de muestras de colores

1. Sidesea crear una nueva muestra de color, haga clicen el botén <+ Add Colour (Agregar color) en la
vista de color. Si desea editar una muestra de color existente, seleccione el color en la vista de color.

2. Realice una de las siguientes acciones para editar la muestra de color:
« En el menu de vista de color, seleccione Colours > Edit (Colores > Editar).
o Haga doble clic en la muestra de color.

Se abre la ventana Coulour Picker (Selector de color).

Multi Wheel Mode

3. Paradefinir el color, realice una de las siguientes acciones:

« Seleccione Red (Rojo), Green (Verde), Blue (Azul), Hue (Matiz), Saturation (Saturacién)
o Value (Valor) para cambiar el espectro del circulo cromatico y, a continuacién, haga
clic en el color que desee en el circulo cromatico.

« Introduzca los valores de matiz, saturacion, valor, rojo, verde y azul de forma manual en
los campos correspondientes. Todos los valores oscilan entre O y 255.

42



Guia de introduccién de Harmony 16.0 Advanced

NOTA

Si cambia una muestra de color después de haber dibujado o pintado con él dreas de un dibujo,
todas las dreas pintadas con este color en los dibujos vectoriales se actualizardn al nuevo color.

Pintado

Puede pintar las zonas cerradas de los dibujos con la herramienta Paint (Pintar).

Cémo pintar dibujos

1. Enlavista de linea de tiempo o de carta de rodaje, seleccione el dibujo que desea pintar.

2. Enlabarra de herramientas de herramientas, seleccione la herramienta ® Paint (Pintar) o pulse Alt

+ 1.
3. Enlavista de color, seleccione una paleta del personaje.

4. Seleccione un color de la paleta.

Scene Palettes

[Adlw ]
‘Wm0 s B *

5. Enlavista de dibujo o de cdmara, comience a pintar el dibujo con los colores.
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NOTA

Al abrir una escena, las paletas de esta no se cargaran inmediatamente en la vista de color.
Primero debe seleccionar un dibujo.

Cierre de huecos

Al pintar, puede encontrar que algunas dreas del dibujo no estaban completamente cerradas debido a
pequefios huecos en los contornos, lo que impide que la herramienta Paint (Pintar) rellene el drea, ya que solo
rellena formas cerradas. Para cerrar la zona, puede dibujar una linea sobre el hueco con la herramienta Brush
(Pincel) o Pencil (Lapiz). Sin embargo, solo es posible cerrar el hueco agregando encima una linea invisible, que
la herramienta Paint (Pintar) considerara como una linea normal. En Harmony, las lineas invisibles utilizadas
para definir las dreas que se deben colorear se denominan lineas vectoriales transparentes.

La herramienta Close Gap (Cerrar hueco) permite cerrar pequenos huecos en el contorno de un dibujo
dibujando al instante una linea vectorial transparente para rellenar el hueco. A diferencia de la herramienta
Stroke (Linea vectorial transparente), con la herramienta Close Gap (Cerrar hueco) no tiene que dibujar con
precisién. Solo tiene que dibujar una linea vectorial transparente bdsica junto al hueco para que se cree
automaticamente una linea vectorial transparente recta que conecte directamente un extremo del hueco al otro.
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Uso de la herramienta Close Gap (Cerrar hueco)

1. Antesde trabajar con lineas vectoriales transparentes, se recomienda habilitar la opcién Show
Strokes (Mostrar |lineas vectoriales transparentes), de modo que pueda verlas en la vista de dibujo o
de cdmara. Puede habilitar la opcién Show Strokes (Mostrar lineas vectoriales transparentes)
realizando una de las siguientes acciones:

« En el menu superior, seleccione View > Show > Show Strokes (Ver > Mostrar >
Mostrar lineas vectoriales transparentes).

e Pulse K
2. Realice una de las siguientes acciones:

o Enlabarrade herramientas de herramientas, seleccione la herramienta ( Close Gap
(Cerrar hueco).

« En el menu superior, seleccione Drawing > Drawing Tools > Close Gap (Dibujo >
Herramientas de dibujo > Cerrar hueco).

e Pulse Alt + C.
3. Enlavista de cdmara o de dibujo, trace una linea invisible cerca del hueco que se va a cerrar.

El hueco se cierra automaticamente.

NOTA

La herramienta Paint (Pintar) también incluye una opcién Close Gap (Cerrar hueco), que se
puede habilitar en la vista de propiedades de la herramienta. Cuando esté habilitada, Harmony
automaticamente intentard encontrar y cerrar pequefios huecos cuando intente rellenar una
forma que no esté cerrada.
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Capitulo 6: Creaciéon de una animacion tradicional sin
papel

Creacidon de un boceto de animacion

El primer paso para crear una animacion sin papel es la creacidén de un boceto, que es el esqueleto de la
animacién. Por lo general, empezarfa animando la parte mds importante de la accién de un personaje. Por
ejemplo, para animar un ciclo de andar, comenzara por el movimiento del torso y de las piernas. Después se
puede agregar una animacién secundaria como la cabeza, los brazos vy la ropa.

Para que la animacién sea satisfactoria, comience animando la accidén principal con esbozos bdsicos y rdpidos y,
a continuacion, agregue los detalles cuando esté satisfecho con el movimiento. Si comienza a animar todos los
detalles inmediatamente, perderd mucho tiempo en caso de tener que realizar correcciones, y es probable que

la animacidn tenga una apariencia rigida.

Creacién de un boceto de animacion

1. En lafila superior de la vista de linea de tiempo, haga clic en [§] Show All Thumbnails (Mostrar todas
las imdgenes en miniatura) para habilitar el modo Thumbnail (Imagen en miniatura).

2. Pulse Ctrl + U (Windows/Linux) o &6 + U (macOS) para abrir el cuadro de didlogo Preferences

(Preferencias).

3. Seleccione la pestafia Exposure Sheet (Carta de exposicidn).
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4. Seleccione la opcién Use Current Frame as Drawing Name (Usar fotograma actual como nombre de
dibujo). Cuando esta preferencia esté habilitada, los dibujos nuevos se nombraran con el ndmero de
fotograma en el que se crearon.

5. En la barra de herramientas de herramientas, seleccione la herramienta &~ Brush (Pincel) o pulse
Alt + B.

6. Enlavista de color, seleccione un color para el pincel. Es una buena idea elegir un color claro para el
boceto de animacién. Esto facilitard el proceso de clean up, ya que las lineas oscuras y limpias hardn
contraste con las lineas esbozadas claras.

7. Enlavista delinea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca
el primer dibujo.

8. En lavista de cdmara o de dibujo, dibuje el primer dibujo clave.

i)

9. Aumente el nivel de zoom de la vista de linea de tiempo hasta que vea las imdgenes en miniatura
dentro de las celdas realizando una de las siguientes acciones:
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o Arrastre el control deslizante K== Timeline Zoom (Zoom de linea de tiempo) hacia la
derecha.

« Haga dlicen la pestafia de la vista de linea de tiempo y pulse 2 de forma reiterada.

o Mueva el cursor del ratdn en la vista de linea de tiempo, mantenga pulsado Ctrl
(Windows/Linux) o &8 (macOS) y gire la rueda del ratdn hacia arriba.

MroSalM

10. Con la primera celda auln seleccionada, realice una de las siguientes acciones para marcar el dibujo
como dibujo clave. Esto le ayudard a mantener el orden.

o Habilite la barra de herramientas Mark Drawing (Marcar dibujo) seleccionando
Windows > Toolbar > Mark Drawing (Ventanas > Barra de herramientas > Marcar
dibujo) en el menti superior v, a continuacién, haga clic en el botén © Mark Selected
Drawings as Key (Marcar como dibujo clave).

« Habilite la barra de herramientas de carta de rodaje centrdndose en la carta de rodaje
y seleccione Windows > Toolbar > Xsheet (Ventanas > Barra de herramientas > Carta
de rodaje) en el menu superior. A continuacion, haga clic en el botén Mark as Key
Drawing (Marcar como dibujo clave) .

o Enelmendde lavista de linea de tiempo, seleccione Drawings > Mark Drawing As >
Key Drawing (Dibujos > Marcar dibujo como > Dibujo clave).

11. Enlavista de linea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca
el préximo dibujo clave.
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12. Enlabarra de herramientas de herramientas, haga clicen el botén é Onion Skin (Papel cebolla).
Esto mostrara los dibujos anteriores y siguientes en un color claro en la vista de cdmara o dibujo,
detrds del dibujo actual, para que pueda utilizarlos como referencias para realizar nuevos dibujos con
precisidn. Esta opcidn puede ser Util para dibujar poses de descomposicidn entre dos poses clave, o
para agregar un dibujo intercalado entre dos otros dibujos.

[ Intervalo de dibujos mostrados en papel cebolla I

13. Asegurese de que el papel cebolla muestre el primer dibujo clave para que pueda basar el segundo
dibujo clave en él. Para llevarlo a cabo, realice una de las siguientes acciones:

o Enlavista de linea de tiempo, haga clicy arrastre la categoria de papel cebolla roja
para que incluya los dibujos anteriores que desea mostrar en el papel cebollay, a
continuacidn, haga clicy arrastre el marcador de papel cebolla verde para que incluya
los siguientes dibujos que desea mostrar en el papel cebolla.

« Utilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar
la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

o Paraaumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botdn é Add Previous Drawing (Agregar dibujo anterior) en la barra de
herramientas de la vista de cdmara/dibujo.

o Parareducir la cantidad de dibujos anteriores que se van a mostrar, haga clicen
el botén == Remove Previous Drawing (Eliminar dibujo anterior) en la barra de
herramientas de la vista de cdmara/dibujo.

o Paraaumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botdn % Add Next Drawing (Agregar dibujo siguiente) en la barra de
herramientas de la vista de cdmara/dibujo.
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o Parareducir la cantidad de dibujos siguientes que se van a mostrar, haga clicen
el botén == Remove Next Drawing (Eliminar dibujo siguiente) en la barra de

herramientas de la vista de cdmara/dibujo.

[ Intervalo de dibujos mostrados en papel cebolla I

NOTA

En la vista de dibujo, puede utilizar la barra de herramientas Onion Skin (Papel
cebolla) para que el papel cebolla solo muestre tipos especificos de dibujos, como
dibujos clave o descomposiciones. Tenga en cuenta que esto no funciona en la

vista de cdmara.

14. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

o Enlabarrade herramientas de linea de tiempo o de carta de rodaje, haga clicen el
botén ¥<| Create Empty Drawing (Crear dibujo vacio).

o Pulse Alt + MayUus + R.

15. En la vista de cdmara o de dibujo, dibuje el segundo dibujo clave.

16. En lavista de carta de rodaje o de linea de tiempo, identifique el dibujo como dibujo clave.
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18. Al usar los marcadores de papel cebolla, asegurese de que el papel cebolla cubra tanto el primer
como el dltimo dibujo.

[ Intervalo de dibujos mostrados en papel cebolla I

19. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

o Enlabarrade herramientas de linea de tiempo o de carta de rodaje, haga clicen el
botén ¥ Create Empty Drawing (Crear dibujo vacio).

o Pulse Alt + Mayds + R.

20. En lavista de camara o de dibujo, dibuje la nueva pose.

21. Enlavista de linea de tiempo o de carta de rodaje, seleccione una nueva celda y repita los pasos
anteriores para cada nuevo dibujo.
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NOTA

Al trabajar con capas de superposicién en la vista de cdmara, puede habilitar la opcién &
Current Drawing on Top (Dibujo actual encima) de la barra de estado debajo de la vista de
cdmara para hacer que la capa en la que estd trabajando aparezca sobre las otras capas.

Revision de la animacidén

Al realizar un flipping por los dibujos se puede ver si los dibujos en los que se estd trabajando conectan bien
entre si'y crean lailusién de movimiento adecuada. Puede desplazarse rdpidamente por los dibujos con los
atajos de teclado para ir al dibujo anterior e ir al dibujo siguiente, o con la barra de herramientas Easy Flipping
(Flipping sencillo).

Desplazamiento por los dibujos

1. Enlavista de linea de tiempo o de carta de rodaje, seleccione el dibujo desde donde desee
desplazarse.

2. Realice una de las siguientes acciones:
o Pulse F parair al dibujo anterior.
o Pulse G parair al dibujo siguiente.

3. Pulse ambos atajos de forma reiterada con rapidez para desplazarse por los dibujos hacia atras o
hacia delante.

Uso de la barra de herramientas Easy Flipping (Flipping sencillo)

1. Cambie a la vista de dibujo.

2. En el menu superior, seleccione Windows > Toolbars > Easy Flipping (Ventanas > Barras de
herramientas > Flipping sencillo) para habilitar la barra de herramientas Easy Flipping (Flipping
sencillo).

Preroll 3

3. Enlabarra de herramientas Easy Flipping (Flipping sencillo), haga clic en el botén <1 Previous
(Anterior) o 1> Next (Siguiente) para ver el dibujo anterior o siguiente de la animacidn.

4. Para mostrar los dibujos del primer fotograma después de llegar al dltimo fotograma de la animacion,
seleccione la opcidén de Loop (Bucle).
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5. Mueva el control deslizante hacia la derecha para desplazarse hacia delante y hacia la izquierda
para desplazarse hacia atrds por los dibujos.

Cuanto mds mueva el control deslizante hacia la izquierda o la derecha, mds deprisa se desplazardn
los dibujos.

6. En el campo Preroll (Preprocesamiento), introduzca la cantidad de dibujos por los que desplazarse
automdticamente antes y después del dibujo actual.

7. En el campo FPS, introduzca la velocidad a la que desee desplazarse automdticamente por los
dibujos en fotogramas por segundo.

8. Hagaclicen el botén » Easy Flip (Flip sencillo) para desplazarse automdaticamente por los dibujos en
funcidn de la configuracién de Preroll (Preprocesamiento) y FPS.

Cuando el boceto de animacidn esté terminado, reprodizcalo para asegurarse de es lo que se esperaba antes
de continuar con el siguiente paso.

Reproduccién de la animacién

1. Enlavista de linea de tiempo, haga clic en el botén del modo ’ Solo a laizquierda de cada capa
que desee ver durante la reproduccién en la vista de linea de tiempo para habilitar el modo (@) Solo
en estas capas.

roSalM

Cuando una o mas capas tengan habilitado el modo Solo, solo se mostrardn las capas que tengan
este modo habilitado, y las otras capas quedardan ocultas.

2. Enlavista delinea de tiempo, mueva el cabezal rojo al primer fotograma de la animacién y haga clic
en el botdn Start (Iniciar) en la barra de herramientas de linea de tiempo. A continuacién, mueva el
cabezal al dltimo fotograma de la animacién y haga clic en el botén Stop (Detener).
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3. Enlabarra de herramientas de reproduccién, haga clicen el botén O Loop (Bucle) para habilitar la

opcidén de bucle durante la reproduccidn.

4. En labarrade herramientas de reproduccion, haga clicen el botén » Play (Reproducir) para

comenzar la reproduccién.

Clean up

Una vez que se haya completado el boceto de animacidn, es el momento de limpiarlo y tintarlo. A este paso
también se le denomina trazado. Consiste en trazar lineas sélidas y limpias sobre el boceto de animacién para
cerrar las zonas abiertas. Es el paso final de la animacidén sin papel antes del paso de ink and paint.

En una animacidn tradicional, los dibujos de clean up se suelen trazar en una nueva hoja de papel con el boceto
debajo, que se puede ver con la mesa de luz del disco de animacién. Del mismo modo, en Harmony, tendra que
agregar una nueva capa de dibujo en el dibujo donde desee dibujar dibujos de clean up. Cuando haya
terminado la limpieza, simplemente puede desactivar la capa que contiene el boceto de animacién para que no
aparezca en la animacion final. Este enfoque también permite mantener los bocetos y los dibujos de clean up
intactos y administrarlos de manera independiente.

En la vista de cdmara, verd el boceto de animacién mientras trabaja en la capa de clean up. Si prefiere trabajar
en la vista de dibujo, puede habilitar la mesa de luz para mostrar el boceto de animacién mientras realiza

trazados en la capa de clean up.

Trazado de la animacién en una nueva capa

1. Enlavista de linea de tiempo, cambie el nombre de la capa en la que cred el boceto de animacion
haciendo doble clic en su nombre e introduciendo el nuevo nombre, por ejemplo: "Boceto".

2. Enlavista delinea de tiempo, agregue una capa realizando una de las siguientes acciones:

o Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clicen el
botén % Add Drawing Layer (Agregar capa de dibujo).

o Pulse Ctrl + R (Windows/Linux) o 38 + R (macOS).

Aparece el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo).
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Add and Close

2. Enelcampo Name (Nombre), escriba el nombre de la nueva capa, por ejemplo: "Clean-up".

2. Seleccione si desea que la capa Line Art (Lineas) sea Vector o Bitmap (Mapa de bits).

3. Seleccione si desea que la capa Colour Art (Color) sea Vector o Bitmap (Mapa de bits).

4. Hagaclicen Add and Close (Agregar y cerrar) para agregar una nueva capay cerrar la ventana.

Se agrega a la vista de linea de tiempo una nueva capa de dibujo.

5. En lavista de linea de tiempo, haga clic en el icono Lock (Bloguear) de la capa que contiene el
boceto de animacién para impedir que dicha capa se pueda seleccionar en la vista de cdmara.

6. Enlavista delinea de tiempo o de carta de rodaje, seleccione la celda de la nueva capa que
corresponda al primer dibujo clave del boceto de animacidn.
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10.

11.

12.

En la barra de herramientas de herramientas, seleccione una herramienta de dibujo, como la
herramienta # Pencil (Lapiz).

En la vista de color, seleccione un color para trazar la animacién. Seleccione un color oscuro intenso,
como el negro, para asegurarse de conseguir un contraste adecuado con el color claro del boceto de
animacion.

En la vista de cdmara o de dibujo, comience a trazar el primer dibujo clave.

NOTA

Si las capas de superposicion estan en medio, puede deshabilitarlas
temporalmente haciendo clic en su botén (€4 Enable/Disable
(Habilitar/deshabilitar) en la vista de linea de tiempo para que solo se muestren el
boceto de animacién y las capas de clean up.

En la vista de linea de tiempo o de carta de rodaje, seleccione la siguiente celda que corresponde a

un boceto de dibujo.

En la barra de herramientas de herramientas, haga clic en el botén == Enable Onion Skin (Habilitar
papel cebolla) para habilitar el papel cebolla.

Aseglrese de que el papel cebolla muestre el dibujo de clean up anterior realizando una de las
siguientes acciones:

« Enlavista de linea de tiempo, haga clicy arrastre la categoria de papel cebolla roja
para que incluya los dibujos anteriores que desea mostrar en el papel cebollay, a
continuacion, haga clicy arrastre el marcador de papel cebolla verde para que incluya
los siguientes dibujos que desea mostrar en el papel cebolla.
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« Utilice los botones de la barra de herramientas sobre el espacio de dibujo para ajustar
la cantidad de dibujos anteriores y siguientes que se van a incluir en el papel cebolla:

o Paraaumentar la cantidad de dibujos anteriores que se van a mostrar, haga clic
en el botdn é Add Previous Drawing (Agregar dibujo anterior) en la barra de
herramientas de la vista de cdmara/dibujo.

o Parareducir la cantidad de dibujos anteriores que se van a mostrar, haga clicen
el botén == Remove Previous Drawing (Eliminar dibujo anterior) en la barra de
herramientas de la vista de cdmara/dibujo.

o Paraaumentar la cantidad de dibujos siguientes que se van a mostrar, haga clic
en el botdn ? Add Next Drawing (Agregar dibujo siguiente) en la barra de
herramientas de la vista de cdmara/dibujo.

o Parareducir la cantidad de dibujos siguientes que se van a mostrar, haga clicen
el botén == Remove Next Drawing (Eliminar dibujo siguiente) en la barra de
herramientas de la vista de cdmara/dibujo.

13. En lavista de cdmara, trace el siguiente dibujo.

57



Capitulo 6: Creacién de una animacidn tradicional sin papel

14. Repita los pasos anteriores para cada dibujo.
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Capitulo 7: Aplicacion de morphing a dibujos

La animacidn dibujada a mano requiere que pase mucho tiempo trazando dibujos intercalados. La funcién de
morphing de Harmony puede ayudar a acelerar el proceso. Esta (til funcidn crea automdaticamente dibujos
generados por ordenador entre los dibujos de vectores para ahorrar tiempo y aumentar la productividad. Puede
modificar facilmente el tiempo vy la velocidad (aceleracidn y desaceleracion gradual) de una animacioén de
morphing.

Uno de los principales usos de la funcién de morphing es la animacidn de efectos. Por ejemplo, la animacién de
humo o agua puede llevar mucho tiempo, ya que estos tipos de efectos suelen ser de movimiento lento, lo que
requiere un gran numero de intercalados estrechamente conectados.

La funcién de morphing se utiliza para animar formas similares y simples, como pelo o humo. De este modo,
podrd ahorrar tiempo durante tareas de intercalado y trazado pesadas. A su vez, le proporciona mas tiempo
para emplearlo en tareas complejas de animacién, como ciclos de andar o secuencias acrobaticas.

Para aprender a aplicar morphing a dibujos, es mejor comenzar con formas bdsicas, como circulos y rectdngulos.
Una vez que esté mas familiarizado con la herramienta, puede aumentar sus conocimientos y experiencia. En
muy poco tiempo, producird algunos efectos notables.

Es dtil conocer los pros y los contras del morphing antes de comenzar. Saber lo que puede hacer y qué lineas de
dibujo pueden ser m3s Utiles o problemdticas le permitirdn disenar dibujos clave para que se transformen de
forma eficiente.

NOTA

Cuanto mds compleja es la forma, mds tarda en transformarse. Si necesita mds tiempo para
transformar un dibujo que para dibujarlo a mano, es mejor animarlo en lugar de aplicar la técnica de
morphing. Sin embargo, si encuentra una ocasion en la que pueda transformar los dibujos, hadgalo.
Permite fijar el tiempo vy la velocidad rdpidamente sin la necesidad de crear dibujos adicionales.
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Creacion de un elemento de morphing basico

1. Enlabarrade herramientas de linea de tiempo, haga clic en el botén ©. Add Drawing Layer
(Agregar capa de dibujo) para agregar una nueva capa al proyecto.

2. Cambie el nombre de la nueva capa (por ejemplo, Morphing).

3. Enlavistadelinea de tiempo o de carta de rodaje, seleccione la primera celda de la capa.

4. Realice una de las siguientes acciones:

« Enlabarrade herramientas de herramientas, seleccione la herramienta [ Rectangle
(Rectangulo).

o Pulse Alt +7.

5. En lavista de cdmara o de dibujo, dibuje un rectangulo.

NOTA

Al dibujar un rectdngulo o una elipsis, puede mantener pulsada la tecla Mayus
para dibujar su forma con las mismas dimensiones, asi como para hacer un
cuadrado o un circulo en su lugar. También puede mantener pulsada la tecla Alt
para dibujar la forma desde su centro y no desde su esquina.

6. Pinte el rectangulo con la herramienta Paint (Pintar).

7. Enlavista de carta de rodaje o de linea de tiempo, seleccione la celda en la que desea que termine la
secuencia de morphing.
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rMo=asHl
“.

8. Realice una de las siguientes acciones:

« Enlabarrade herramientas de herramientas, seleccione la herramienta O Ellipse
(Elipse).

o Pulse Alt + =.

9. Dibujey pinte la elipse con el mismo contorno y colores de relleno que en el rectangulo.

10. En lavista de carta de rodaje o de linea de tiempo, seleccione el rango de fotogramas que va desde
el primer dibujo hasta el segundo dibujo, incluidos los fotogramas que contienen los mismos.

wO=all
{t.

11. Realice una de las siguientes acciones:

« En el mend superior, seleccione Animation > Morphing > Create Morphing (Animacién
> Morphing > Crear morphing).

« En lavista de carta de rodaje o de linea de tiempo, haga clic con el botdn derechoy
seleccione Morphing > Create Morphing (Morphing > Crear Morphing).

o Pulse Alt + M.

Aparecen las flechas que van desde el primer dibujo clave hasta el segundo dibujo clave, que indican
que se han creado los intercalados generados por ordenador.
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Ajuste de la velocidad de morphing

Si observa la animacién, notara que el movimiento de morphing es constante. Para producir un movimiento
menos mecanico, es probable que desee crear alguna aceleracidn o desaceleracidén-gradual.

Adicion de aceleracion y desaceleracién-gradual a un elemento de morphing

1. Enlabarrade herramientas de herramientas, seleccione la herramienta ?}) Morphing o pulse F3.

2. Enlavista delinea de tiempo, haga clic en un fotograma de la secuencia de morphing que desee

ajustar.

3. Enlavista de propiedades de la herramienta, aumente o reduzca el valor de Ease In (Aceleracién-
gradual) y Ease Out (Desaceleracién-gradual) para ajustar la velocidad de la secuencia.

4 Mmain

a

Adicion de sugerencias de morphing

La herramienta Morphing de Harmony permite controlar su secuencia de morphing de muchas maneras. Una
de esas maneras es colocar sugerencias para asegurarse de que Harmony transforme los dibujos de la manera

que tenfa prevista.

Las sugerencias son puntos que se colocan en los dibujos de origen y de destino para asociar zonasy lineas
entre los dos dibujos. Se utilizan para corregir errores de las transformaciones de dibujos que realiza Harmony,
como una linea que no sigue la zona de relleno de color o cuando una parte del dibujo de origen no se
transforma en su parte correspondiente del dibujo de destino. De forma predeterminada, Harmony asociara

63



Capitulo 7: Aplicacién de morphing a dibujos

una esquina o un punto en el dibujo de origen con la esquina o punto mds cercanos del dibujo de destino. Por lo
tanto, las sugerencias son necesarias si la forma que se va a transformar o su movimiento son complejos.

Adicion de sugerencias

1. En lavista de linea de tiempo o de carta de rodaje, seleccione el dibujo de origen de la secuencia de
morphing.

2. Enlabarra de herramientas de herramientas, seleccione la herramienta P}) Morphing o pulse F3.

Utilice como referencia el otro dibujo clave de morphing, mostrado en la esquina inferior derecha de
la vista de dibujo.

o Seleccione Contour Hint (Sugerencia de contorno) para corregir el contorno de una

linea de pincel o de una zona de color (vector de contorno).

Los puntos de Contour Hint (Sugerencia de contorno) se comportaran de manera
similar que los puntos de Pencil Hint (Sugerencia de Idpiz) cuando se utilizan en una
linea de ldpiz. Tenga en cuenta que obtiene mejores resultados utilizando el punto de
Pencil Hint (Sugerencia de 1dpiz) en la linea de Idpiz en lugar de los puntos de Contour
Hint (Sugerencia de contorno).

« Seleccione Pencil Hint (Sugerencia de Idpiz) para corregir una linea de lapiz (vector
central).
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o Seleccione Zone Hint (Sugerencia de zona) para corregir una coincidencia de
morphing de zona de color.

« Seleccione Vanishing Point Hint (Sugerencia de punto de fuga) para corregir la

trayectoria de una forma de fuga.

« Seleccione Appearing Point Hint (Sugerencia de punto de aparicidn) para corregir la
trayectoria de una forma de aparicion.

4. En lavista de cdmara o de dibujo, haga clic en el dibujo situado junto al drea problematica.

5. Seleccione el punto de la sugerencia y muévalo a su posicidon correcta.

6. Enlavistadelinea de tiempo o de carta de rodaje, seleccione el dibujo de destino.

7. Busgue y mueva el punto de la sugerencia correspondiente a la parte coincidente del dibujo de

destino.

—(0)
Q)
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8. Enla barra de herramientas de reproduccién, pulse el botén » Play (Reproducir) para ver el
resultado.
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Capitulo 8: Importacion de imagenes

De forma predeterminada, Harmony trabaja con imdgenes de vectores creadas dentro de su propia interfaz.
Las imagenes de vectores se componen principalmente de informacién sobre las distintas formas que
componen las imdgenes, asi como de sus colores de linea y de relleno. Esto hace que sean faciles de editar y
pintar, y permite redimensionarlas sin que afecte a la calidad de la imagen. Por el contrario, las imdgenes de
mapa de bits se componen de informacién de color sobre cada pixel individual que compone la imagen. Por lo
tanto, son mas adecuados para imdgenes muy detalladas o realistas, pero no se pueden escalar sin perder
calidad de imagen, ni se pueden editar tan facilmente como las imagenes de vectores.

Normalmente, es necesario trabajar con imdgenes de mapa de bits si debe crear algunos de los recursos de
escena, como fondos o props, en un software diferente. A continuacién, puede importar los archivos de
imagenes de mapa de bits en su escena de Harmony.

Alimportar una imagen de mapa de bits, debe decidir cémo debe procesarla Harmony. Puede elegir entre las

siguientes opciones:

« Keep as Original Bitmap (Mantener como mapa de bits original) (Importar como mapa de bits): importa la
imagen exactamente tal como estd y garantiza que no se pueda modificar cuando se trabaje en la
escena. Esta opcidn es (til para utilizar fondos creados en el proyecto con un software diferente.

« Import as Toon Boom Bitmap Drawing (Importar como dibujo de mapa de bits de Toon Boom): importa
la imagen tal como estd, pero permite editarla con las herramientas de dibujo de mapa de bits de
Harmony.

o Import as Toon Boom Vector Drawing (Importar como dibujo de vector de Toon Boom): convierte un
mapa de bits en un dibujo vectorial de Toon Boom que se puede pintar y editar facilmente con las
herramientas de dibujo vectorial de Harmony. Esta opcién puede ser (til para la importacién de capa de
lineas escaneadas o creadas con un software diferente.

Importaciéon de una imagen de mapa de bits en su formato original

1. Realice una de las siguientes acciones:

« En el menu superior, seleccione File > Import > Images (Archivo > Importar >
Imdgenes).

« Enlabarra de herramientas File (Archivo), haga clic en el botén Import Images
(Importar imagenes) .

« Enlavista de carta de rodaje, haga clic con el botén derecho en cualquier parte del
drea de fotogramas y seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de didlogo Import Images (Importar imagenes).
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Cancel

2. Enla seccidén Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clicen
Browse (Examinar) para buscar y seleccionar una o mds imdgenes en el ordenador.

3. Agregue laimagen de mapa de bits a una nueva capa seleccionando la opcién Create Layer(s)
(Crear capas) y una de las siguientes opciones:

o Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imdgenes en ella.

o Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tgay b-1.tga, se creardn dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendrd las dos primeras
imagenes, mientras que la "b" contendrd la tercera.

« Add to a Existing Layer (Agregar a una capa existente): Importa las imdgenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacidn. Por ejemplo, si va a importar imdgenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

4. En la seccidén Vectorization (Vectorizacidn), asegurese de que la opcién Vectorize Image (Vectorizar
imagen) no esté marcada.

5. En la seccién Import Options (Opciones de importacidn), seleccione la opcién Keep As Original
Bitmap (Mantener como mapa de bits original).

6. Enlaseccién Alignment (Alineacidn), decida el tamafo vy la posicién de la imagen dentro del
encuadre de cdmara. Puede elegir entre las siguientes opciones:
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Pardmetro

Descripcién

Fit (Ajustar)

Ajusta el tamafio de laimagen para que se adapte completamente al campo de
la escena, tanto vertical como horizontalmente, asegurdndose de que toda la

imagen sea visible.

Si la orientacién de laimagen es vertical, ajustard la altura de la imagen para que
se adapte a la altura del campo sin que afecte a la proporcidén de la imagen:

Imagen vertical con regla
de alineacién de ajuste

Si la orientacién de la imagen es horizontal, ajustard el ancho de la imagen para
que se adapte al ancho del campo sin que afecte a la proporcién de laimagen:

Imagen harizontal con regla
de alineacién de ajuste

Fi de escena

Fi de escena

Resoclucidn
de camara

Resoclucidn
de camara

Pan
(Panear)

Esto tiene el efecto opuesto al pardmetro de ajuste. La dimensién mds pequena
de laimagen se ajustard a la dimensidn coincidente del fotograma de la escena,
y la dimensién mds grande de la imagen se ajustard proporcionalmente,
haciendo que laimagen llene todo el campo de la escena y abarque mads alld de
sus limites si su proporcién no coincide con la proporcién del campo. Esta
opcidn se puede utilizar para importar una imagen de fondo de paneo, también

denominada paneo.
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Si la orientacidn de la imagen es vertical, ajustard el ancho de la imagen para
que se adapte al ancho del campo sin que afecte a su proporcién:

Imagen vertical con
regla de alineacidn
de paneo

Resolucidn
de camara

Fotograma de escena (cuadricula)

Si la orientacidn de la imagen es horizontal, ajustard la altura de la imagen para
que se adapte a la altura del campo sin que afecte a su proporcidn:

F de escena

i Resolucién  imagen horizontal con regla de alineacion de paneo
Project Escala laimagen para que se ajuste a la resolucién de la escena, haciendo que
Resolution cada pixel de la imagen tome un pixel del campo de la escena. Por ejemplo, si
(Resolucién las dimensiones de la imagen en pixeles son la mitad de la resolucién de la
de escena en pixeles, las dimensiones de la imagen parecerdn ser la mitad de las
proyecto) dimensiones del campo de la escena.

7. Enlaseccién Transparency (Transparencia) decida cdmo desea que se suavice la imagen de mapa
de bits, en concreto, la forma en que los pixeles a lo largo del borde se mezclan con los otros
colores. Puede elegir entre las siguientes opciones:

Pardmetro Descripcién

Premultiplied Los pixeles individuales del borde de una imagen se mezclan con blanco.
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with White
(Premultiplicado
con blanco)

Premultiplied
with Black , o .
. Los pixeles individuales del borde de una imagen se mezclan con negro.
(Premultiplicado

con negro)

. Los pixeles del borde de una imagen se mezclan con negro, blanco y
Straight (Recto) .
grises.

Premultiplica el valor de color con el valor de alfa. Cuando el color se fija al
alfa, el valor de color no puede ser mayor que el valor de alfa. Calcula el

Clamp Colour to valor de color real mas rdpido. Cuando los valores de RGB se multiplican
Alpha (Fijar con el valor de alfa, por ejemplo, si tiene un pixel con el valor R=247,
color a alfa) G=188, B=29y el alfa es del 50 % o la imagen tiene una transparencia del

50 %, los valores de RGB reales que se generan serian la mitad de las
cantidades indicadas.

8. Hagaclicen OK (Aceptar).

NOTA

De forma predeterminada, las imdgenes de mapa de bits se mostraran en baja resolucién en la
vista de cdmara para evitar que afecten al rendimiento de la reproduccién. También puede
ajustar la calidad de visualizacién de una imagen de mapa de bits selecciondndola con la
herramienta Transform (Transformar) y, a continuacién, abriendo el cuadro de didlogo Bitmap
Image Quality (Calidad de la imagen de mapa de bits) a través de View > Bitmap File Quality
(Vista > Calidad del archivo de mapa de bits). También puede previsualizar la imagen de mapa
de bits en la resolucidn de la escena activando el modo Render Preview (Vista de render) en
la vista de cdmara.

Vectorizacion de imagenes

Harmony permite importar imdgenes como dibujos de vectores. Los dibujos de vectores se pueden pintary
editar facilmente con las herramientas de dibujo de vectores de Harmony. Esto puede ser Util parala
importacion de capa de lineas escaneadas o creadas con un software diferente, ya que luego puede pintarla en
Harmony.
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Importaciéon de una imagen de mapa de bits como un dibujo de mapa de bits de Toon
Boom

1. Realice una de las siguientes acciones:

« En el menu superior, seleccione File > Import > Images (Archivo > Importar >
Imdgenes).

« Enlabarra de herramientas File (Archivo), haga clic en el botén Import Images

(Importar imagenes) .

« Enlavista de carta de rodaje, haga clic con el botén derecho en cualquier parte del
drea de fotogramas y seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de didlogo Import Images (Importar imdgenes).

1. En la seccidn Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clicen
Browse (Examinar) para seleccionar una o mds imagenes del ordenador.

2. Seleccione el destino de las imdgenes:

o Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imdgenes en ella.

o Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo dnico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se creardn dos capas, una
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denominada "a" y otra denominada "b". La capa "a" contendra las dos primeras
imagenes, mientras que la "b" contendrd la tercera.

« Add to a Existing Layer (Agregar a una capa existente): Importa las imagenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacién. Por ejemplo, si va a importar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

2. Enla seccién Alignment (Alineacién), decida el tamafio y la posicién de laimagen dentro del
fotograma de la cdmara. Puede elegir entre las siguientes opciones:

Parametro Descripcién

Ajusta el tamafio de la imagen para que su altura coincida con la altura de la
escena, sin que afecte a su proporcion.

Vertical Fit
(Ajuste
vertical)
Resolucidn
de camara
Imagen con ragla de
alineacién de ajuste vertical Fotograma de escena (cuadricula)
Horizontal . B . o
Fit (Ajust Ajusta el tamafo de la imagen para que su ancho coincida con el de la escena
it (Ajuste ; ,
. sin que afecte a su proporcidén.
horizontal)
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Resclucién
de camara

LT:E:;:::;?]:Jasf:honzontal Fatog e ssrans toule)
Actual Importa laimagen a tamafio real sin ajustar su tamafio en proporcién ala
Size resolucidn de la escena. Por ejemplo, si las dimensiones de la imagen en pixeles
(Tamano son la mitad de la resolucidn de la escena en pixeles, las dimensiones de la
real) imagen parecerdn ser la mitad de las dimensiones del campo de la escena.

3. Enlaseccidén Transparency (Transparencia) decida cdmo desea que se suavice la imagen de mapa
de bits, en concreto, la forma en que los pixeles a lo largo del borde se mezclan con los otros
colores. Puede elegir entre las siguientes opciones:

Parametro Descripcién

Premultiplied with White Los pixeles individuales del borde de una imagen se
(Premultiplicado con blanco) mezclan con blanco.

Premultiplied with Black Los pixeles individuales del borde de una imagen se
(Premultiplicado con negro) mezclan con negro.

Straight (Recto) Los pixeles del borde de una imagen se mezclan con
rai ecto
d negro, blanco y grises.

4. Haga clicen OK (Aceptar).

Importacidn y vectorizacién de una imagen de mapa de bits

1. Realice una de las siguientes acciones:
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« En el menu superior, seleccione File > Import > Images (Archivo > Importar >
Imdgenes).

« Enlabarrade herramientas File (Archivo), haga clic en el botén Import Images
(Importar imagenes) .

« Enlavista de carta de rodaje, haga clic con el botén derecho en cualquier parte del
drea de fotogramasy seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de didlogo Import Images (Importar imdgenes).

Cancel

1. En la seccién Files (Archivos) del cuadro de didlogo Import Images (Importar imdgenes), haga clicen
Browse (Examinar) para seleccionar una o mas imagenes del ordenador.

2. Seleccione el destino de las imdgenes:

o Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imdgenes en ella.

o Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se creardn dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendrd las dos primeras
imagenes, mientras que la "b" contendrd la tercera.

« Add to a Existing Layer (Agregar a una capa existente): Importa las imdgenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
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compatibles con las opciones de importacién. Por ejemplo, si va a importar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

3. Enlaseccién Import Options (Opciones de importacion), seleccione la opcién Convert to Toon Boom
Vector Drawing (Convertir a dibujo de vector de Toon Boom).

4. En la seccidn Vectorization (Vectorizacidn), decida si desea importar laimagen en blanco y negro, o
en grises. También puede hacer clic en el botdn New Preset (Nuevo valor predef.) para crear un
pardametro de vectorizacién personalizado.

» Black and White (Blanco y negro): vectoriza los dibujos como una linea negra sdlida; crea un
dibujo 100 % basado en vectores. Los contornos de los dibujos se pintaradn con la muestra de
color de la linea vectorizada de la paleta de colores de la escena.

» Grey (Gris): vectoriza la imagen como una mezcla de contorno de vectoresy relleno de mapa de
bits en escala de grises. Las lineas conservan la textura de la digitalizacién, y el blanco del papel
pasa a ser transparente.

Valor predefinido de

Valor predefinido de gris blanco y negro

NOTA

Puede hacer doble clic en los valores predefinidos en cualquier momento para abrir el cuadro de
didlogo Vectorization Parameters (Pardametros de vectorizacidn) para personalizar su opcion.

5. Haga clicen OK (Aceptar).

Las imdgenes vectorizadas apareceran en los destinos seleccionados.

77



Capitulo 8: Importacién de imagenes

NOTA

Si tiene imagenes de mapa de bits en la librerfa, puede arrastrarlas y colocarlas directamente en la
escena como una manera rapida de importar una imagen de mapa de bits. Sin embargo, no tendrd
acceso a todas las opciones de importacion.
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Capitulo 9: Colocacion y animacion de capas

La configuracién de una escena se puede comparar con la construccién de la escenografia para un programa de
televisién. Este es el punto en el que coloca el elemento de escena, como el encuadre de cdmara, los elementos
de fondo vy los personajes.

Colocacién de capas

El primer paso para configurar la escena es colocar cada capa en su posicién, dngulo y tamafio iniciales. Puede
realizar cualquier tipo de transformacién geométrica en una capa con la herramienta i.} Transform
(Transformar).

Paneo, rotacidn, escala o sesgo de una capa con la herramienta Transform
(Transformar)

1. Enlabarrade herramientas de herramientas, seleccione la herramienta {.! Transform (Transformar)
o pulse Mayus + T.

2. Enlabarrade herramientas de herramientas, si estd habilitado el modo Animate Current Frame
(Animar fotograma actual) o g\% Animate Onion Skin Range (Animar intervalo de papel cebolla),
haga clic en él para abrir el menut emergente Animate (Animar) y seleccione % Animate Off
(Animar desactivado).

3. Enlavista de propiedades de la herramienta, asegurese de que la opcién  Peg Selection Mode
(Modo de seleccién de peg) estd desactivada.

4. En lavista de cdmara o de linea de tiempo, haga clic en la capa que desea manipular para
seleccionarla.

SUGERENCIAS

« Sidesea seleccionar varias capas en la vista de cdmara, mantenga pulsado Mayus y
haga clic en cada capa gue desee seleccionar.

« Sidesea seleccionar varias capas en la vista de linea de tiempo, mantenga pulsado
Ctrl (Windows/Linux) o 36 (macOS) y haga clic en cada capa que desee seleccionar.

« Sidesea seleccionar una serie contigua de capas en la vista de linea de tiempo,
mantenga pulsado MayUs, haga clic en la primera capa que desea seleccionar y luego
en la dltima.
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Aparece un cuadro de control del manipulador alrededor de la capa seleccionada.

| Escalar verticalmente |Sesgar horizontalmente |

Rotar Rotar

| Escalar horizontal y verticalmente 7—' Escalar horizontal y verticalmente |

—| Sesgar verticalmente |

. :)—| Escalar horizontalmente |

: Punto de pivote I

| Escalar horizontalmente
D—| Escalar horizontal y verticalmente |

| Escalar verticalmente |Sesgar horizontalmente |

| Sesgar verticalmente

1. Realice una de las siguientes acciones:

« Mover: mueva el cursor por lailustracién. Cuando el cursor se convierta en +}#, haga clicy
arrdstrelo sobre la ilustracién para moverla.

« Rotar: coloque el puntero fuera de una esquina del cuadro de limite. Cuando el cursor se
conviertaen ), haga clicy arrdstrelo para rotar.

ﬁ o

« Escalar: mueva el cursor sobre cualquiera de los puntos de control amarillos del cuadro del
manipulador. Cuando el cursor se convierta en ", haga clicy arrastre para escalar la capa.
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@ NOTA

Al realizar el escalado de la seleccién, puede mantener pulsado MayUs para
mantener las proporciones entre el ancho vy la altura.

« Mueva el cursor sobre uno de los bordes verticales del cuadro del manipulador. Cuando el
cursor se convierta en 1[ , haga clicy arrastre hacia arriba o hacia abajo para sesgar la capa
en vertical.

« Mueva el cursor sobre uno de los bordes horizontales del cuadro del manipulador. Cuando el
cursor se convierta en ¥, haga clicy arrastre hacia la izquierda o hacia la derecha para
sesgar la capa en horizontal.
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Cambio de posicién del pivote

Las transformaciones realizadas sobre una capa de dibujo, tales como rotacidn, escala, sesgo y volteo, se
realizan de forma relativa a la posicién del punto de pivote del dibujo. Por ejemplo, al rotar una capa, esta rotara
alrededor de su punto de pivote, y al escalar la capa, se escalard como si su centro fuera realmente su punto de
pivote.

Mientras realiza transformaciones con la herramienta Transform (Transformar), puede arrastrar y colocar el
pivote de la seleccién. Sin embargo, esto no tiene un efecto permanente. Solo cambiard temporalmente la
posicién del pivote para que le ayude a realizar transformaciones en el fotograma seleccionado, pero el punto de
pivote real de la capa de dibujo permanecerd igual.

Puede cambiar de forma permanente la posicién del punto de pivote de una capa utilizando una de las
herramientas de la barra de herramientas Advanced Animation (Animacién avanzada).

NOTA

Al mover de forma permanente el punto de pivote de una capa que ya estd animada, todas las
transformaciones realizadas en la capa en otros fotogramas clave se volveran a calcular de acuerdo
con la posicidn del nuevo punto de pivote. Por lo tanto, la animacidn existente tendrd una
apariencia completamente diferente, excepto en el fotograma actual. Es recomendable que siempre
se asegure de que el punto de pivote se encuentre en la posicién idénea antes de comenzar a

animar.

Cambio de posicion permanente del punto de pivote

1. Enlabarrade herramientas Advanced Animation (Animacién avanzada), seleccione la herramienta
*I* Translate (Traslacién), (<} Rotate (Rotar), [ Scale (Escalar) o /7 Skew (Sesgar).

2. Realice una de las siguientes acciones:
o En lavista de linea de tiempo, seleccione la capa a la que desee mover el pivote.

o Enlavista de cdmara, utilice Ctrl + clic (Windows/Linux) o 3£ + clic (macOS) en la capa para la
que desea mover el pivote.

El punto de pivote @ aparece en la vista de cdmara.

Punto de pivote

83



Capitulo 9: Colocacién y animacién de capas

3. Mueva el cursor sobre el punto de pivote. Cuando el cursor del ratén se convierta en '—& haga clicy
arrastrelo al punto de pivote para cambiar de posicién.

El punto de pivote de la capa ha cambiado de posicidn. Si la capa se ha animado, su posicidn se
desplazard por las escenas de forma relativa a la cantidad que acaba de desplazar el punto de
pivote.
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Animacion de una capa

Puede animar una capa colocdndola en diferentes posiciones, angulos y tamafos en distintos puntos a lo largo
de la linea de tiempo de la escena. Para ello, puede crear fotogramas clave de animacién en la capa. Un
fotograma clave registra las transformaciones geométricas en una capa en un punto especifico en el tiempo.
Cuando dos fotogramas clave de animacidn se encuentren en una capa en diferentes puntos de la linea de
tiempo de la escena, Harmony interpolard automdticamente la posicidn, el dngulo y el tamafio de la capa en
cada fotograma entre esos dos fotogramas clave, creando una animacion.

Colocar en el segundo
fotograma clave

Colocar en el primer
fotograma clave

[ Colocar para cada fotograma intercalado

Animacion de una capa

1. Enlabarrade herramientas de herramientas, seleccione la herramienta {.! Transform (Transformar)
o pulse Mayus + T.

2. Enlabarra de herramientas de herramientas, si estd seleccionado el modo % Animate Off (Animar
desactivado) o gﬁ Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clicen él
para abrir el mend emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual).

3. Silacapa tiene un peg padre:

« Sideseaanimar en el peg en lugar de en la capa, asegurese de que el modo /x Peg Selection
(Seleccidn de peg) esté habilitado en la vista de propiedades de la herramienta.

« Sidesea animar directamente en la capa, asegUrese de que el modo /& Peg Selection
(Seleccidn de peg) esté desactivado en la vista de propiedades de la herramienta.

4. En lavista de linea de tiempo, vaya al primer fotograma.

5. En el mend superior, seleccione Animation (Animacién) y asegurese de que la opcién Stop-Motion
Keyframe (Fotograma clave de Stop-motion) no estd marcada. De este modo, Harmony creard la
animacién automdaticamente entre los fotogramas clave de la animacién que cree.

6. Seleccione la celda donde desee crear el primer fotograma clave.
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7. Para crear el primer fotograma clave, realice una de las siguientes acciones:

o Enlabarrade herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

o Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

o Pulse F6.

Se crea un fotograma clave en el primer fotograma de la vista de linea de tiempo.

Fotograma clave

8. Enlavista de cdmara, seleccione el elemento que desea animar y muévalo a su primera posicidn.

ro=alm
o

10. Seleccione la celda donde desee crear el segundo fotograma clave. clic con el botén derecho en la
seleccidn y seleccione Insert Keyframe (Insertar fotograma clave).

El segundo fotograma clave aparece en la lista de linea de tiempo, junto con una linea desde el

primer fotograma clave al segundo fotograma clave. Esto indica que cada fotograma intercalado se
animard mediante Harmony.

ro=al
o

Fotograma clave

11. En lavista de cdmara, mueva el elemento a su segunda posicion.
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12.

13.

En la vista de linea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la
animacién.

En la barra de herramientas de reproduccidn, haga clicen el botén » Play (Reproducir) para
obtener una vista previa de la animacidn.

NOTA

Sianima capas en el eje Z, puede gque desee obtener una vista previa de las animaciones desde
las vistas superior, lateral o de perspectiva durante la reproduccién. Sin embargo, la
reproduccidn estd deshabilitada de forma predeterminada en esas vistas. Para habilitarlas, en
el mend superior seleccione Play > Enable Playback > Top View (Reproducir > Activar
reproduccién > Vista superior), Side View (Vista lateral) o Perspective View (Vista de
perspectiva).
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Capitulo 10: Colocacion y animacion de la camara

En Harmony, puede animar objetos dibujandolos en su capa individual y colocdndolos a continuacién en
distintas ubicaciones en diferentes fotogramas clave a través de la linea de tiempo para crear una ruta de
movimiento. Se puede aplicar el mismo principio a la cdmara de la escena, ya que se trata de una capa.

Adicion de una camara

De forma predeterminada, una escena no tiene capa de cdmara. Para poder ajustar el angulo de la cdmaray la
posicién de la escena, debe agregar una a su escena.

Adicién de una cdmara

1. Realice una de las siguientes acciones:

« Enlavistadelinea de tiempo, haga clicen el botén 4+, Add Layer (Agregar capa) del
menu emergente y seleccione Camera (Cdmara).

« En el menu superior, seleccione Insert > Camera (Insertar > Cadmara).

Se agrega a la escena una nueva capa de camara y aparece en la vista de linea de tiempo.

Aunque es posible tener varias cdmaras en la misma escena, solo puede ver su escena utilizando las cdmaras de
una en una. Esto puede resultar (til si aln estd trabajando en la composicién de escena y tiene distintas
configuraciones de cdmara para probar.

Cambio entre cdmaras

1. En el menu superior, seleccione Scene > Camera (Escena > Cdmara).

2. Entrelas cdmaras en la lista, seleccione la cdmara con la que desea trabajar.

Adicion de un peg padre

Aunque es posible colocar una cdmara sin necesidad de sin necesidad de conectarla a un peg, se recomienda
hacerlo por dos motivos:

« Permite colocar, rotar y alejar o acercar la cdmara con la herramienta Transform (Transformar).

« Permite animar los movimientos de la cdmara. Sin un peg padre, la posicién, el anguloy el zoom de la
cdmara son estaticos.
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Adicion de un peg padre a una camara

1. Enlavista de linea de tiempo, seleccione la capa de cdmara.

2. Enlabarra de herramientas Layers (Capas), haga clicen el botén (3 Add Peg (Agregar peg).

Aparece una capa de peg directamente sobre la capa de cdmara y se conecta a ella

automaticamente.

Colocacién de la camara

La accidn de la escena tiene lugar dentro del encuadre de cdmara, de modo que es muy importante configurarlo
correctamente. Puede ajustar la resolucién de la cdmara y otros parametros relacionados en la ventana Scene
Settings (Configuracion de escena), a la que se puede acceder desde el menu principal de Scene (Escena).

Para cambiar la posicién de la cdmara directamente, puede moverla con la herramienta .1 Transform
(Transformar) o *%* Translate (Traslacién), puede rotarla con la herramienta (& Rotate (Rotar) y puede alejarla o
acercarla con la herramienta (7l Scale (Escalar) de la barra de herramientas Advanced Animation (Animacidn
avanzada). También puede escribir sus coordenadas directamente en la vista de propiedades de capa. Si ha
usado un rig de cdmara debajo de un peg, puede aplicarle todo tipo de manipulaciones solo con la herramienta
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Transform (Transformar). Los siguientes pasos indican cémo manipular la cdmara al sin necesidad de conectarla
aun peg.

Colocacién de una camara en la que se ha usado un rig debajo de un peg en la vista de
camara

1. Realice una de las siguientes acciones para seleccionar el peg padre de la cdmara.

« Enlavista de linea de tiempo, haga clicen la capa del peg padre de la cdmara.

« Enlavista de cdmara, haga clic en el fotograma de la cdmara. El fotograma de la cdmara es un
rectangulo fino alrededor de la etapa de la escena.

Aparece un cuadro de control alrededor del fotograma de la cdmara.

| Acercar o alejar pe—o

Acercar o alejar

Mowver

Mowver

Mowver

il

Acercar o alejar

Acercar o alejar i

2. Realice una de las siguientes acciones:

« Mover el fotograma de la cdmara: Coloque el cursor sobre cualquiera de sus bordes o sobre el
centro. Cuando el cursor cambie a +}+, haga clicy arrdstrelo en el fotograma de la cdmara para
cambiarlo de posicién.
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« Acercar o alejar: Coloque el cursor en una de las esquinas del fotograma de la cdmara.
Cuando el cursor cambie a ™., haga clicy arrdstrelo a la esquina para cambiar el tamaio del
fotograma de la cdmara. Al contraer el fotograma de la cdmara se acercara la escena, y al
expandirlo, se alejara.

« Rotarla cdmara: Coloque el cursor fuera de una de sus esquinas. Cuando el cursor cambie a
¢, haga clicy arrastrelo para rotar el fotograma de la cdmara.

Animacion de la camara

La cdmara de una escena se puede manipular y animar como cualquier otra capa. Se muestra en la vista de linea
de tiempo y puede utilizar las mismas herramientas y modos de seleccién para compensarla o animarla. Sin
embargo, la capa de la cdmara en si es estdtica, lo que significa que mantiene la misma posicién y dngulo en toda
la escena. Para poder animar la cdmara, es necesario conectarla a una capa de peg, que se puede animar, y que
afectard directamente a la posicion y al angulo de la cdmara.

Puede animar los movimientos de la cdmara directamente en la vista de cdmara.
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Animacion de la cdmara

1. Enlabarrade herramientas de herramientas, active el modo Animate <~ (Animar).

2. Enlabarra de herramientas de herramientas, seleccione la herramienta .1 Transform (Transformar)

o pulse Mayus + T.

3. Enellado derecho de la vista de linea de tiempo, en la capa de peg de camara, seleccione el
fotograma en el que desee que comience el movimiento de cdmara.

4. Realice una de las siguientes acciones para agregar un fotograma clave:

« Enlabarra de herramientas de linea de tiempo, haga clicen el botén & Add Keyframe

(Agregar fotograma clave).
« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.

Aparece un fotograma clave en dicha celda. Los fotogramas que preceden a este fotograma clave
mantendradn la misma posicién de cdmara que este fotograma clave.

5. En lavista de cdmara, manipule la cdmara para que esté en la posicién correcta cuando la cdmara

comience a moverse.

6. En lavista de linea de tiempo, haga clic en la celda en la que terminara el movimiento de camara.
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7. Realice una de las siguientes acciones:

o Enlabarrade herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe
(Agregar fotograma clave).

o Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

o Pulse F6.

Aparece un fotograma clave en dicha celda.

8. Enlavista de cdmara, manipule la cdmara para que esté en la posicién correcta cuando la cdmara

termine de moverse.

9. Enlavistadelinea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la

animacion.

10. Enlabarra de herramientas de reproduccidn, haga clic en el botén » Play (Reproducir) para

obtener una vista previa de la animacién.
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Capitulo 11: Creacidn de un rig de un personaje Cut-
out

En Harmony, un rig de personaje es basicamente una plantilla basada en el modelo del personaje, peroen la
cual todas las partes mdviles estan divididas en distintas capas y ordenadas en una jerarquia que facilita la
animacién digital, también conocida como animacidén cut-out.

Para realizar un rig de personaje, en primer lugar debemos asegurarnos de tener un modelo de personaje del
que partir. Si tiene un dibujo de un personaje disponible, impdrtelo en una nueva escena'y, a continuacion,
ajuste la escala y coldéquelo a su gusto. De lo contrario, puede dibujar el modelo del personaje directamente en
Harmony. Una vez que tenga listo un modelo, podemos comenzar a descomponerlo en partes para crear el rig
con él.

Se pueden emplear muchas técnicas para descomponer una marioneta. En esta seccidén, aprenderd uno de los
métodos mas comunes y sencillos. Para la primera descomposicién de personaje, siga estas instrucciones para
hacerse una idea de cémo funciona Harmony. Una vez que conozca las funciones y comandos bdsicos de
Harmony, podra crear sus propias técnicas para cumplir las necesidades de su produccidn.

7!

N

Dibujo de las piezas

La técnica de descomposicidn principal que se muestra es el trazado del modelo.

Descomposicion de un personaje mediante trazado

1. Enlavista de linea de tiempo, aflada una nueva capa de dibujo para cada parte del cuerpo que
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desee separar. Puede pulsar Ctrl + R (Windows/Linux) o 3£ + R (macOS) para agregar nuevas capas
de dibujo.

+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1

3. Enlabarra de herramientas de herramientas, seleccione la herramienta de dibujo que desee.
Existen dos métodos que se suelen utilizar para dibujar las partes de un modelo de personaje cut-
out:

o Utilizar la herramienta # Pencil (L4piz) y suavizar las lineas con la herramienta R
Smooth Editor (Editor suave).

o Utilizar la herramienta G Polyline (Polilinea). Este método permite dibujar con gran
precisidn, pero puede llevar mas tiempo.

Estos métodos garantizan que cada parte se realice con el menor ndmero de puntos posible, para
que sean faciles de manipular, modificar o volver a dibujar.

4. En lavista de color, seleccione una muestra de color. Si todavia no ha creado ninguna paleta para el
personaje, consulte Cémo pintar en la pagina 40.

5. Siprefiere trabajar en la vista de dibujo, realice una de las siguientes acciones para mostrar las
demds capas con colores descoloridos:

« Enlabarra de herramientas de la vista de dibujo, haga clicen el botén ¢ Light Table
(Mesa de luz).

o Pulse MayUs + L.

6. Enlavista de cdmara o de dibujo, dibuje la nueva parte.
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7.

10.

Si desea cerrar una forma abierta sin dibujar un contorno visible, puede dibujar una linea visible con
la herramienta (~ Stroke (Linea vectorial transparente).

NOTA

Las lineas vectoriales transparentes no son visibles de forma predeterminada. Para ver
las lineas vectoriales transparentes en el dibujo, seleccione View > Show > Show
Strokes (Ver > Mostrar > Mostrar lineas vectoriales transparentes) en el menu superior o
pulse K.

En la barra de herramientas de herramientas, seleccione la herramienta ® Paint (Pintar) o pulse ®
Paint Unpainted (Pintar drea no pintada) para colorear el dibujo.

En la vista de color, cree el color de relleno deseado si no se encuentra todavia en la paletay, a
continuacion, selecciénelo.

En la vista de cdmara o de dibujo, pinte el dibujo.
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11. Enlabarra de herramientas de herramientas, seleccione la herramienta X Select (Seleccionar).
Seleccione el dibujo y acople las lineas haciendo clic en el botén = Flatten (Acoplar) de la vista de
propiedades de la herramienta.

12. Silaslineas estdan compuestas por varias pinceladas de ldpiz, puede que desee combinarlas en una
Unica linea de |dpiz fluida. Mediante la herramienta Select (Seleccionar), seleccione las lineas de lapiz
gue se deben combinary, en la vista de propiedades de la herramienta, haga clicen el botén %
Merge Pencil Lines (Combinar lineas de lapiz).

13. Repita todo el proceso para cada parte del cuerpo que desee que se pueda animar.
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it H{

Adicion de pegs

Los pegs son un tipo especial de capa que no contiene ningun dibujo. Solo se utilizan para manipular y
transformar dibujos que estén debajo de su jerarquia, sin transformar directamente los dibujos.

Al crear un rig o configurar una escena, se recomienda emparentar pegs a cada una de las capas de dibujo. De
este modo, se permite mantener los fotogramas clave y los dibujos de animacidn en capas separadas, lo que
facilita el trabajo sobre la posicidn y exposicién de las capas de dibujo por separado en la vista de linea de
tiempo. También facilita la creacién de una jerarquia de las partes del cuerpo que se pueden animar juntasy por
separado.

T —

Si desea animar solo sobre pegs, puede activar el modo Peg Selection (Seleccién de peg) de la herramienta
Transform (Transformar) en la vista de propiedades de la herramienta. También puede deshabilitar las capas de
dibujo de animacidn, ya que solo se pueden animar los pegs.
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NOTA

También es posible hacer que una capa de dibujo sea el padre de otra capa de dibujo. Al igual que la
forma de animacién de un peg anima sus capas hijas, la animacién de una capa de dibujo con hijos
también animarad sus capas hijas. Ambas capas seguirdn apareciendo en la animacidn.

Cémo emparentar pegs a las capas en la vista de linea de tiempo

1. En lavista de linea de tiempo, seleccione todas las capas.

+
|

¥
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+++++
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2. Enlabarra de herramientas de capa de linea de tiempo, haga clicen el botén (% Add Peg (Agregar
peg) para agregar un peg padre a todas las capas seleccionadas.

')

+
1

+

#

+
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Creacion de una jerarquia de capas

Harmony permite crear el rig en una jerarquia elaborada, lo que permite a su vez establecer qué partes del rig
deben influir en otros miembros y cémo pueden moverse de forma independiente. Por ejemplo, al crear un rig
del brazo de un personaje simple, puede hacer que la capa del antebrazo sea hija de la capa del brazo, y que la
capa de la mano sea hija de la capa del antebrazo. De esta manera, si el personaje mueve el antebrazo, la mano
también lo hard, y si mueve el brazo, el antebrazo y la mano también lo hardn.

%l ™ '! 4—‘ Jerarquia de cabeza ‘
Jerarquia de : Jerarquia de
brazo derecho brazo izquierdo

)

v {J..,-
¥ ' '[.u
Jerarquia de -« Jerarquia de
pierna derecha pierna izquierda

Al crear un rig de personaje bdsico, debe tener al menos una jerarquia para cada brazo y cada pierna. Puede
crear una jerarguia que vaya desde el torso, el cuello y la cabeza, y crear un rig de los brazos al torso y otro de las

piernas a las caderas. Esto crearfa una jerarqufa como esta:

Creacion de una jerarquia en la vista de linea de tiempo

1. En el dreaizquierda de la vista de linea de tiempo, seleccione la capa que desee que sea la capa hija.
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2. Arrastre el hijo y coléquelo sobre la capa que desee que sea la capa padre. Aseglrese de no colocar
la capa hija entre dos capas.

3. Repita el proceso hasta que haya creado una jerarquia que manipule todas las partes del personaje,
con un peg maestro en la raiz. Al crear un rig, si desea que varias capas tengan un padre comun,
pero ninguna de las partes existentes del rig puede servir como dicho padre, cree un nuevo pegy
anide esas capas debajo de dicho peg.

Sin pegs

+ “+ % +
+ + +
+ + +
+ + +
+ + +
+ + +
+ + +
+ + +
+ + +

NOTA

En la vista de linea de tiempo, puede desconectar una capa de su capa padre manteniendo
presionada la tecla Mayus, arrastrando la capa padre lejos de la capa hija y colocdndola en
cualquier lugar de la lista.

Al crear un rig, tenga en cuenta que el orden de las capas en la vista de linea de tiempo afecta al orden en que
se representan. Las capas de la parte superior de la lista se representardn sobre las capas de la parte inferior de
la lista. Si tiene que cambiar el orden de una capa durante la animacién, puede realizar un desplazamiento
pequefio de la posicidn de esta capa sobre el eje Z para anular el orden de la capa y forzarla a aparecer debajo o
sobre otras capas.

Desplazamiento pequefo de una capa sobre el eje Z

1. Enlabarrade herramientas de herramientas, seleccione la herramienta .1 Transform
(Transformar).

2. Enlavista delinea de tiempo, de nodos o de camara, seleccione la capa que desea desplazar.

3. Siha seleccionado la capa en la vista de linea de tiempo o de nodos, haga clic en la pestana de la
vista de cdmara para establecer el enfoque en esta vista.

4. Realice una de las siguientes acciones:

101



Capitulo 11: Creacidén de un rig de un personaje Cut-out

o Pararealizar un desplazamiento pequeno de la capa hacia delante, pulse Alt + flecha
abajo.

« Para realizar un desplazamiento pequefio de la capa hacia atras, pulse Alt + flecha
arriba.

Peg maestro

El rig del personaje siempre debe tener un peg maestro que se conecta a todas sus partes. El peg maestro
permite manipular todo el rig desde una Unica capa, sin necesidad de manipular cada parte individual. Esto es
Util para colocar y escalar el personaje en relacidn a la escena, asi como para animar la trayectoria del personaje
cuando tiene que moverse entre las dreas de la escena.

Adicion de un peg maestro en la vista de linea de tiempo

1. Enlavista de linea de tiempo, seleccione la capa superior.
2. Enlavista delinea de tiempo, haga clicen el botén (% Add Peg (Agregar peg).

Se agrega a la linea de tiempo un nuevo peg al que queda emparentada la capa seleccionada.
3. Asigne el nombre Master mas el nombre del personaje al nuevo peg.

4. En lavistadelinea de tiempo, seleccione todas las capas que desee conectar al nuevo peg. Recuerde
gue la capa superior ya es un hijo del peg, asi que no lo incluya en la seleccién.

5. Arrastre la seleccion SOBRE la capa del peg para emparentar todas las piezas del personaje al peg.
Si se agregan capas encima de las capas que ya tienen padres, mueva dicha capa con padres de
nuevo a la parte superior de la pila de capas.
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Capitulo 12: Animacion de un personaje Cut-out

Harmony ofrece herramientas muy Utiles para animar modelos de personajes cut-out. Con la herramienta
Transform (Transformar), puede mover las partes del personaje para crear poses clave, mientras que Harmony
crea los intercalados. El tiempo del movimiento se puede ajustar para crear movimientos realistas y los dibujos
de las partes del personaje se pueden intercambiar en cualquier punto de la animacién, permitiendo combinar
los cambios del movimiento y del dibujo para crear animaciones cut-out perfectamente ajustadas.

Creacion de una animacién Cut-out simple

Crearemos una animacion Cut-out simple realizando la primera pose del personaje en el primer fotograma,
la segunda pose en el siguiente fotograma y permitiendo que Harmony las interpole.

1. Enlavista de linea de tiempo, contraiga el personaje con la flecha Expand/Collapse

(Expandir/Contraer).

3. Paragarantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicidn) realizando una de las siguientes acciones:

« Haga clic con el botén derecho en el primer fotograma de la vista de linea de tiempo y
seleccione Extend Exposure (Extender exposicion).
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e Pulse F5.

4. En el cuadro de didlogo Extend Exposure (Extender exposicidn), escriba el nimero de fotogramas de
la escena y confirme. De este modo, el modelo quedard expuesto (serd visible) en toda la escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mas tarde, la primera pose no se verd afectada. Para llevarlo a cabo, realice una
de las siguientes acciones:

« Enlabarrade herramientas de linea de tiempo, haga clic en el botén ¢r Add Keyframe (Agregar
fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.

Se agrega un fotograma clave al fotograma actual.

4. En labarra de herramientas de herramientas, seleccione la herramienta {.! Transform (Transformar)
o pulse Mayus + T.

5. En labarra de herramientas de herramientas, si estd seleccionado el modo $ Animate Off (Animar
desactivado) o g\% Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clicen él
para abrir el mend emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual).

6. Enlavista de cdmara, seleccione las partes que desea animar. El cuadro de control de la herramienta
Transform (Transformar) aparecera alrededor de la capa seleccionada. Cada parte del cuadro de
control de la herramienta Transform (Transformar) se puede usar para realizar distintos tipos de
transformaciones:

Cambiar tamario
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7.

11.

Utilice la herramienta | Transform (Transformar) para rotar, sesgar, escalar o trasladar la seleccién
a su nueva posicion.

Repitalo en otras partes del modelo del personaje hasta que la primera pose haya terminado.
En la barra de herramientas de herramientas, active la funcién é Onion Skin (Papel cebolla).

En la vista de linea de tiempo, seleccione el fotograma donde desee tener la segunda pose.

3

Cree un fotograma clave para la segunda pose realizando una de las siguientes acciones:

« En labarra de herramientas de linea de tiempo, haga clicen el botén & Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

El segundo fotograma clave aparece, junto con una linea desde el primer fotograma clave al segundo
fotograma clave. Esto indica que cada fotograma intercalado se interpolara mediante Harmony.

Si no aparece ninguna linea, significa que se ha creado el primer fotograma clave como un fotograma
clave de Stop-motion. Para resolverlo, realice una de las siguientes acciones:

« Haga clic con el botén derecho en el primer fotograma clave y seleccione Set Motion
Keyframe (Definir fotograma clave de movimiento).

« Seleccione el primer fotograma clave y pulse Ctrl + K (Windows/Linux) o & + K (macOS)
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Para asegurarse de que los nuevos fotogramas clave se establezcan en Motion (Movimiento) de
forma predeterminada, seleccione Animation (Animacidén) en el menu superior y asegurese de que la
opcidn Stop-Motion Keyframe (Fotograma clave de Stop-motion) no esté activada.

NOTA

Cada fotograma clave puede ser un fotograma clave de movimiento o un fotograma
clave de Stop-motion. Los fotogramas entre dos fotogramas clave estdn interpolados
por Harmony si el primero de los dos fotogramas clave es un fotograma clave de
movimiento.

12. En lavista de cdmara, cambie de nuevo la pose del personaje.

Capa
seleccionada

13. Repita este proceso para todas las poses que desee agregar a la animacion.

Ajuste de la velocidad de la animacién
1. Enlavista de linea de tiempo, contraiga la jerarquia del modelo del personaje.

2. Seleccione uno de los fotogramas clave de la animacidn. Mientras que la jerarquia del modelo se
contrae, esto selecciona el fotograma clave en cada capa simultdneamente.

3. Realice una de las siguientes acciones:

« Enlavista de linea de tiempo, haga clic con el botdn derecho y seleccione Set Ease For
Multiple Parameters (Definir aceleracion para varios pardmetros).
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o Enlabarrade herramientas de linea de tiempo, haga clic en el botén =~ Set Ease For
Multiple Parameters (Definir aceleracidn para varios parametros).

Se abre el cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracién para varios

pardmetros).

EEEEEE

Apply fPrevious Apply Apply

4. En el gréfico, tire del controlador de la curva Bézier para ajustar la velocidad de todas las funciones

seleccionadas.

5. Para aplicar estos pardametros de velocidad Unicamente a un tipo de funcién determinado, como
Rotation (Rotacidn) o Scale (Escala), en la seccién Filters (Filtros), anule la seleccién de los tipos de
funcidn a los que no desee que se apliquen.

« Motion (Movimiento): aplica los pardmetros de velocidad a las funciones Position X
(Posicidén X), Position Y (Posicién Y), Position Z (Posicién Z) y 3D Path (Ruta 3D)
seleccionadas.

« Rotation (Rotacién): aplica los pardmetros de velocidad a las funciones de dangulo
seleccionadas.
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« Scale (Escala): aplica los pardmetros de velocidad a las funciones de escala
seleccionadas.

o Skew (Sesgar): aplica los pardmetros de velocidad a las funciones de inclinacién
seleccionadas.

« Morphing: aplica los pardmetros de velocidad a las funciones de velocidad de
morphing seleccionadas. Tenga en cuenta que se aplica cuando la funcién Morphing
Velocity (Velocidad de morphing) de la ventana Layer Properties (Propiedades de
capa), no es la velocidad de morphing bdsica en la vista de propiedades de la
herramienta.

o Other (Otras): aplica los parametros de velocidad a todas las demas funciones
seleccionadas, como todas las funciones creadas para animar parametros de efecto.

6. También puede ajustar la velocidad introduciendo valores en los campos Time Ratio (Ratio de
tiempo) y Value Ratio (Ratio de valor). Los valores se calculan como un porcentaje.

e Enlos campos Left Time Ratio (Ratio de tiempo izquierdo) y Right Time Ratio (Ratio de
tiempo derecho), escriba el valor como porcentaje correspondiente al tiempo que
desea que dure la velocidad. El valor debe estar entre el 0 % y el 100 %.

o En los campos Left Value Ratio (Ratio de valor izquierdo) y Right Value Ratio (Ratio de
valor derecho), escriba el valor como porcentaje correspondiente a la intensidad que
desea que tenga la desaceleracion. El valor debe estar entre el 0 %y el 100 %.

« Silos valores Time Ratio (Ratio de tiempo) y Value Ratio (Ratio de valor) son iguales, el
movimiento serd lineal.

7. Haga clicen uno de los siguientes botones:

« Apply/Previous (Aplicar/anterior): aplica los pardmetros de velocidad a los fotogramas
clave seleccionados y automdticamente se selecciona seleccione el fotograma clave
anterior en la linea de tiempo.

« Apply (Aplicar): aplica los pardametros de velocidad a los fotogramas clave
seleccionados.

« Apply/Next (Aplicar/siguiente): aplica los pardmetros de velocidad a los fotogramas
clave seleccionados y automdticamente se selecciona el fotograma clave siguiente en la
linea de tiempo.

« Close (Cerrar): cierra el cuadro de didlogo. Si no ha aplicado las modificaciones, se
cancelaran.
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NOTA

Si se selecciona un rango que contiene varios fotogramas clave, solo el primer fotograma clave
seleccionado se verd afectado por la funcién Set Ease for Multiple Parameters (Definir

aceleracidn para varios parametros).

Desplazamiento por las capas

Dado que la animacidn cut-out normalmente implica modelos complejos con amplias jerarquias, aprender los
atajos para desplazarse facilmente entre las capas puede ahorrar mucho tiempo.

Un truco de gran utilidad para aprender es el comando Centre on Selection (Centrar en seleccién), junto con su
atajo de teclado. Este comando permite desplazarse directamente a la capa seleccionada en la vista de linea de
tiempo. Por lo tanto, puede usar la vista de cdmara para seleccionar de forma visual la capa con la que desee
trabajar y, a continuacidn, usar el atajo de Centre on Selection (Centrar en seleccidn) para encontrar la capa en
la vista de linea de tiempo, en lugar de revisar la estructura de la escena para localizarla.

Centrado en la seleccion actual en la vista de linea de tiempo

1. Enlavista de linea de tiempo, contraiga todas las capas.

2. Enlabarra de herramientas de herramientas, seleccione la herramienta i.! Transform

(Transformar).
3. Enlavista de cdmara, seleccione una capa.
4. Realice una de las siguientes acciones:

« Hagadlicen la pestafia de la vista de linea de tiempo para ajustar el centrado en la

misma y, a continuacion, pulse O.

o Enlabarrade herramientas de la vista de linea de tiempo, haga clic en el botdn

Centre on Selection (Centrar en seleccidn).

La vista de linea de tiempo estd ahora centrada en la capa seleccionada y todos sus padres se han

expandido automaticamente.

Si desea usar el atajo de teclado con frecuencia, le puede parecer que es cansado tener que hacer clicen la
pestafia de vista de linea de tiempo cada vez. Para resolverlo, puede habilitar la preferencia Focus On Mouse
Enter (Centrarse en ratdn). Ajustara el centrado en una vista en cuanto el cursor del ratén entre en ellay hard

funcionales al instante todos los atajos de teclado de esta vista.

110



Guia de introduccién de Harmony 16.0 Advanced

Activacién de la preferencia Focus On Mouse Enter (Centrarse en ratoén)

1. En el menu superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows/Linux) o Harmony

> Preferences (Harmony > Preferencias) (Mac OS X).

2. Abrala pestafa General.

3. Enla seccién Options (Opciones), active la casilla de verificacion Focus On Mouse Enter (Centrarse

en ratdn).
4. Haga clicen OK (Aceptar).

Los atajos de teclado para vistas especificas funcionaran en cuanto el cursor del ratén entre en la

vista prevista.

Harmony también tiene comandos y atajos de teclado para cambiar rdpidamente la seleccién de la capa
seleccionada actualmente a su su padre, su hijo o uno de sus hermanos, permitiendo asi el desplazamiento con
rapidez por la jerarquia del personaje desde una capa a una de sus capas relacionadas.

Seleccién del padre o del hijo de la capa seleccionada

1. Enlabarrade herramientas de herramientas, seleccione la herramienta .1 Transform

(Transformar).

2. Enlavista de propiedades de la herramienta Transform (Transformar), asegurese de que esté
desactivado el modo & Peg Selection (Seleccién de peg).

3. Enlavista de cdmara o de linea de tiempo, seleccione una capa u objeto conectado a una jerarquia.

)

Y

) O

Q

4. Realice una de las siguientes acciones:

« Seleccione Animation > Select Parent (Animacién > Seleccionar padre) o pulse B para

seleccionar la capa padre.

o Seleccione Animation > Select Child (Animacién > Seleccionar hijo) o pulse Mayus + B para

seleccionar la capa hija.
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« Seleccione Animation > Select Children (Animacién > Seleccionar hijos) para seleccionar

todas las capas hijas al mismo tiempo.

NOTA

Al subir o bajar la jerarquia de nodos, estos atajos de teclado omiten cualquier nodo de efecto
de la jerarquiay solo seleccionan peg o nodos de dibujo. Esto se debe a que estos atajos se
optimizan para la animacién Cut-out. En la pestafa Shortcuts (Atajos de teclado) del cuadro de
didlogo Preferences (Preferencias), en General, estos atajos de teclado se denominan
realmente Select Parent Skipping Effects (Seleccionar padre omitiendo efectos) y Select
Child Skipping Effects (Seleccionar hijos omitiendo efectos). Si desea utilizar los atajos de
teclado para navegar por la jerarquia sin omitir los nodos de efectos, puede asignar atajos de
teclado personalizados para los comandos Select Parent (Seleccionar padre) y Select Child
(Seleccionar hijo).

Seleccidn de los hermanos de la capa seleccionada

1. En lavista de linea de tiempo, seleccione una capa que tenga al menos un hermano vy realice una de
las siguientes acciones:

« Para seleccionar el hermano previo de la familia, pulse /.

« Para seleccionar el siguiente hermano de la familia, pulse la tecla de signo de
interrogacion (?).

T ‘+
|
¥
#

Hermano anterior
il Siguiente hermano

o
o
o
o
o
o
o
o
e
o
o

(| | [+
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Capitulo 13: Uso de deformadores

Los deformadores permiten animar objetos y partes de un modelo de personaje mediante las deformaciones
generadas por ordenador. Permite doblar o distorsionar los dibujos sin necesidad de volver a dibujarlos. Cuando
se usa en una animacion cut-out, puede ampliar notablemente una gama de movimientos y poses que un
modelo de personaje pueda conseguir sin necesidad de haber dibujado ninguna de sus partes en diferentes
poses, lo que supone un ahorro de tiempo y hace que la animacidén cut-out parezca mucho mds natural con
menos esfuerzo.

Los deformadores se pueden usar para deformar una Unica capa de dibujo o una jerarquia de capas, de manera
que un solo deformador se puede usar para deformar lo que sea desde un prop hasta un rig de personaje
completo. Se puede usar tanto en dibujos vectoriales como en dibujos de mapa de bits.

Los deformadores funcionan al crear un rig con ellos como padres del dibujo que desee deformar, crear una
estructura de deformador vy, a continuacién, animarlo. Se puede realizar facilmente con la herramienta {T

Rigging.
Hay dos tipos de deformadores disponibles en Harmony Advanced:
o Hueso

o Hueso para juego

NOTA

Harmony Premium también admite los deformadores de curva y de distorsidon de envolvente, que
ofrecen funciones de deformacién ampliadas que no son compatibles con Harmony Advanced.

Deformador de huesos

La deformacién de hueso permite crear una estructura similar al hueso en la que cada parte es sdlida, pero las
articulaciones son flexibles. Esto es sobre todo Util para la animacién de los miembros de un personaje, como los
brazos o las piernas, u otras partes que se puedan articular, como torsos o dedos. Por ejemplo, se puede utilizar
una deformacién de hueso para articular un brazo que estd hecho de un solo dibujo, de modo que el brazoy el
antebrazo se puedan mover de forma independiente, sin necesidad de dibujar la parte superior del brazoy el
antebrazo en capas diferentes. Harmony deformard el dibujo para que parezca que estd articulado. Las
distintas partes de una deformacidn de hueso se pueden rotar alrededor de su articulacidon, extenderse y
acortarse, proporcionandole las mismas capacidades que las articulaciones de animacién en distintas capas, sin
tener que preocuparse por la separacion de piezas, puntos de pivote o recorte de contornos.
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Hueso
4 Articulacion

O

Deformador de hueso para juego

La deformacién de hueso para juego es parecida a la deformacion de hueso. Permite crear una estructura similar
al hueso en la que cada parte es sélida, pero las articulaciones son flexibles. Sin embargo, se optimiza para
motores de juego como Unity. Por lo tanto, generalmente se usa para desarrollo de juegos y no en producciones
animadas. A diferencia de las deformaciones de hueso, las deformaciones de hueso para juego no tienen una
propiedad de sesgo. Los pliegues de la articulacién también parecen ligeramente mas redondos.

4 Articulacion

R*s

Hueso

Creacion de deformadores

La manera mds sencilla de crear deformadores es usar la herramienta {T Rigging, disponible en la barra de
herramientas de deformacidn. Con esta herramienta, todo lo que necesita hacer para crear un deformador es
seleccionar la capa que desee deformar y, a continuacidn, colocar cada punto del deformador en la vista de

camara.
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Los deformadores existen en la escena como una jerarquia de capas de deformacién. Cuando crea un nuevo
deformador, el primer punto que define es la raiz del deformador y cada punto nuevo que crea es un hijo del
punto anterior. Por lo tanto, los deformadores se crean en una cadena y se deben crear teniendo en cuenta la
jerarguia del personaje. Por ejemplo, si crea un deformador para un brazo, la raiz debe ser la articulacion del
hombro, el segundo punto debe ser el codo y el tercero, la muneca.

Seleccidén del elemento en el que crear un deformador

Un deformador afecta a todas las capas que hay debajo de su jerarquia. Al crear un nuevo deformador
utilizando la herramienta rigging, se crea automaticamente como padre de la capa seleccionada, y afectard
a la capa seleccionada y a todos sus hijos. Por lo tanto, es importante seleccionar la capa correcta antes de
intentar crear un deformador.

Por ejemplo, si se desea crear un deformador para un brazoy el brazo se divide en varias capas, se puede
crear un rig del brazo en una jerarquia donde el brazo superior sea la raiz, el antebrazo sea el hijo del brazo
superior y la mano sea el hijo del antebrazo. A continuacidn, si crea su deformador en la parte superior del
brazo, se creard como padre de la parte superior del brazoy, por lo tanto, afectara a todo el brazo.

También puede agrupar varias capas debajo de un peg y crear su deformador con este peg seleccionado. Al
crear un deformador en un peg, el deformador se crea como un hijo del peg, pero como padre de todos los
hijos de este peg. Esto se debe a que es probable que un peg sea mas Util sobre un deformador que debajo.
Si mueve las capas que estdn debajo un deformador, saldrdn de la zona de deformacion prevista y pueden
aparecer muy deformadas y distorsionadas. Por lo tanto, es mejor crear todas las deformaciones posibles
debajo de los pegs, y los pegs que estén debajo de los deformadores solo deben animarse si el deformador
se queda intacto. Dado que el deformador se creara como padre de todos los hijos del peg, afectard a todas
las capas que haya debajo de este.

Creacién de un deformador de hueso

1. Unavez seleccionado el elemento, seleccione la herramienta {T Rigging en la barra de
herramientas de deformacion.
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2. En lavista de propiedades de la herramienta, habilite el modo £ Bone (Hueso).

3. Cologue el cursor en la raiz del dibujo o de la jerarquia de dibujo, haga clic una vez y suéltelo. Por
ejemplo, si va a crear un deformador para todo el brazo, haga clic en la articulacién del hombro.

L TN

4. Mueva el cursor en la ubicacidn en la que desee que termine el primer hueso y que comience el

segundo hueso, y haga clic de nuevo. Se insertard automaticamente un punto de control de
articulacién entre cada hueso que cree.

5. Mueva el cursor donde desee que se situe la siguiente articulacidn y haga clic para crear el siguiente
punto.

Observe que, al crear un nuevo punto, el anterior aparece ahora rodeado por un circulo. Se trata del
radio de la articulacién, lo que permite determinar qué cantidad de dibujo debe formar parte de la
articulacién. Cada punto de un deformador de hueso, a excepcidn del primero y del dltimo, cuenta
con un punto de ajuste de radio.

6. Haga clicy mantenga pulsado el manipulador del radio de la articulacién anterior y ajuste el radio de
la articulacion de modo que cubra el miembro.
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7. Repita el proceso hasta que haya terminado de crear la cadena de huesos. AsegUrese de crear cada
articulacién en el orden correcto desde la raiz hasta la extremidad.

Visualizacidn de deformadores

Harmony permite controlar qué deformadores se muestran en la vista de cdmara independientemente de la
seleccién actual. Al crear una cadena de deformacion, sus controles de deformacién se muestran en la vista de
camara. Sin embargo, si selecciona un deformador existente o una capa que esté conectada a deformadores
existentes, sus controles de deformacién no se mostrardn inmediatamente. Asimismo, al desactivar una cadena
de deformacidn no se ocultardn sus controles de deformacién. Para poder animar o modificar una cadena de
deformacién existente, debe mostrarla de forma manual.

Visualizacidon de los controles de deformacidon

1. Realice una de las siguientes acciones:

o Enlavista de cdmara o de linea de tiempo, seleccione uno de los elementos de dibujo
vinculados a la cadena de deformacion que desee visualizar.

« Enlavista de linea de tiempo, seleccione cualquier parte de la cadena de deformacién que
desee visualizar.

2. Enlabarra de herramientas de deformacidn, haga clicen el botén & Show the Selected
Deformation Chain and Hide All Others (Mostrar la cadena de deformacién seleccionada y ocultar el
resto).

Los controles de deformacién seleccionados aparecen en la vista de cdmara, y los demds quedan
ocultos.

NOTA

El botén Show the Selected Deformation Chain and Hide All Others (Mostrar la cadena de
deformacidn seleccionada y ocultar el resto) mostrara todas las cadenas de deformacidn que se
encuentran en la jerarquia de la seleccidn. Por ejemplo, si estd seleccionado el peg maestro de
un modelo de personaje, se mostraran todas sus cadenas de deformacién. Asimismo, si estan
seleccionadas varias capas vinculadas con distintas cadenas de deformacidn, se mostraran
todas sus cadenas de deformacidn.

Cémo ocultar los controles de deformacién

1. Realice una de las siguientes acciones:

118



Guia de introduccién de Harmony 16.0 Advanced

« Haga clicen el espacio negativo de la vista de cdmara, de linea de tiempo o de nodos
para descartar la seleccién actual y, a continuacidn, haga clicen el botén €~ Show the
Selected Deformation Chain and Hide All Others (Mostrar la cadena de deformacién
seleccionada y ocultar el resto) de la barra de herramientas de deformacidn.

« Seleccione una capa que no esté vinculada a ningun deformador vy, a continuacidn,
haga clicen el botédn < Show the Selected Deformation Chain and Hide All Others
(Mostrar la cadena de deformacién seleccionada y ocultar el resto) de la barra de
herramientas de deformacidn.

o Enlabarrade herramientas de cdmara, haga clic en el botén Hide All Controls (Ocultar
todos los controles) .

« En el menu superior, seleccione View > Hide All Controls (Ver > Ocultar todos los
controles).

o Pulse Mayls + C.

Modificacidn de las cadenas de deformacion existentes

A medida que intenta animar una deformacidn, o si necesita realizar cambios en los dibujos de una deformacion,
es posible que deba realizar ajustes en la cadena de deformacidn para que se adapte mejor a sus necesidades.

Adicién de una articulacién a una deformacién de hueso o hueso para juego existente

1. Seleccione la capa de dibujo o la cadena de deformacidn a la que desea agregar una articulacion.

2. Enlabarrade herramientas de deformacién, haga clicen el botén < Show the Selected
Deformation Chain and Hide All Others (Mostrar la cadena de deformacidn seleccionada y ocultar el
resto) para mostrar los controles de deformacidn en la vista de cdmara. De este modo, también se
ocultan todos los controles de deformacidn visualizados.

3. Seleccione la herramienta {T Rigging.

La cadena de deformacién cambia de verde a rojo. Una cadena verde indica que estd animando la
deformacién. Una cadena roja indica que estd modificando el rig.

4. Mueva el cursor sobre el segmento de hueso donde desea agregar una articulacién.

5. Mantenga pulsado Alt y haga clic.
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Realizacion de ajustes en los deformadores existentes

1. Seleccione la capa de dibujo o la cadena de deformacién para la que necesita realizar ajustes.

2. Enlabarra de herramientas de deformacién, haga clicen el botén < Show the Selected
Deformation Chain and Hide All Others (Mostrar la cadena de deformacidn seleccionada y ocultar el
resto) para mostrar los controles de deformacidn en la vista de cdmara. De este modo, también se
ocultan todos los controles de deformacién visualizados.

3. Enlabarra de herramientas de deformacién, haga clic en la herramienta {T Rigging.

La cadena de deformacién cambia de verde a rojo. Una cadena verde indica que estd animando la
deformacién. Una cadena roja indica que estd modificando el rig.

Ao

4. En lavista de cdmara, configure la cadena de deformacién.

« Gire el primer hueso para cambiar el dngulo de la cadena.
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Il

« Utilice el control raiz para cambiar de posicién (desplazar) toda la cadena.

« Utilice puntos de control para cambiar de posicidn las articulaciones. De este modo se
alargard, acortara o cambiard la direccién del hueso. Esto también compensard los
demds puntos de la cadena de deformacidon.

}
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« Utilice el control de la articulacién (cuadrado) para cambiar el tamafo de la misma. Por
motivos de calidad, se recomienda que el didmetro de la articulacion se ajuste al de la
parte que controla.

5. Repita el proceso hasta que todas las articulaciones y huesos de la cadena estén correctamente
alineados con el elemento con el que estan vinculados.

NOTA

Al manipular la articulacién de un hueso o hueso para juego, puede mantener pulsada la tecla
Alt para bloquear el angulo del hueso y solo acortar o alargar el hueso. También puede
mantener pulsada la tecla Ctrl (Windows/Linux) o 36 (macOS) para romper la articulacién de su
cadena y transformarla en una nueva cadena de deformador independiente.

Animacion con deformadores

Aligual que con los pegs de animacién y las capas de dibujo, puede animar los deformadores creando
fotogramas clave en sus capas correspondientes en la linea de tiempo. La animacién de deformadores funciona
exactamente igual que la realizaciéon de modificaciones en un deformador, excepto que requiere el uso de la
herramienta Transform (Transformar) en lugar de la herramienta Rigging. Al seleccionar la herramienta
Transform (Transformar), los controles de deformacién de la vista de cdmara se muestran de color verde, lo que
significa que se encuentran en modo de animacién, mientras que cuando se selecciona la herramienta Rigging,
se muestran en rojo, lo que significa que se encuentran en modo de rigging.

Animacién de deformaciones de hueso y hueso para juego

1. Enlavista de linea de tiempo, contraiga el personaje con la flecha Expand/Collapse
(Expandir/Contraer).
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3. Para garantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicidn) realizando una de las siguientes acciones:

« Haga clic con el botdn derecho en el primer fotograma de la vista de linea de tiempoy
seleccione Extend Exposure (Extender exposicion).

e Pulse F5.

4. En el cuadro de didlogo Extend Exposure (Extender exposicién), escriba el ndmero de fotogramas de
la escena y confirme. De este modo, el modelo quedara expuesto (serd visible) en toda la escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mads tarde, la primera pose no se vera afectada. Para llevarlo a cabo, realice una
de las siguientes acciones:

« En labarra de herramientas de linea de tiempo, haga clicen el botén ¢ Add Keyframe (Agregar
fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.

Se agrega un fotograma clave al fotograma actual.

4. En labarra de herramientas de herramientas, seleccione la herramienta {.! Transform (Transformar)
o pulse Mayus + T.

5. Enlabarra de herramientas de herramientas, si estd seleccionado el modo % Animate Off (Animar
desactivado) o g\% Animate Onion Skin Range (Animar intervalo de papel cebolla), haga clicen él
para abrir el mend emergente Animate (Animar) y seleccione Animate Current Frame (Animar
fotograma actual).
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6. Realice una de las siguientes acciones:

« Enlavista de cdmara o de linea de tiempo, seleccione uno de los elementos de dibujo
vinculados a la cadena de deformacién que desee visualizar.

« En lavista de linea de tiempo, seleccione cualquier parte de la cadena de deformacién que
desee visualizar.

7. Enlabarra de herramientas de deformacién, haga clicen el botén & Show the Selected
Deformation Chain and Hide All Others (Mostrar la cadena de deformacién seleccionada y ocultar el
resto).

Los controles de deformacidn seleccionados aparecen en la vista de cdmara, y los demds quedan
ocultos.

8. Enlavista de cdmara, realice lo siguiente:

o Gire el primer hueso para rotar el miembro.

« Utilice el control raiz para cambiar de posicion (desplazar) toda la cadena.

124



Guia de introduccién de Harmony 16.0 Advanced

« Utilice puntos de control para cambiar de posicidn las articulaciones. De este modo se
alargard, acortard o cambiard la direccién del hueso, y se compensaran los demas hijos.

AW

9. Enlavista delinea de tiempo, vaya al fotograma en el que desee definir la siguiente pose clave.
10. Agregue un fotograma clave en el fotograma actual realizando una de las siguientes acciones:

« Enlabarrade herramientas de linea de tiempo, haga clicen el botén * Add

Keyframe (Agregar fotograma clave).
« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.
11. Transforme los puntos de la cadena de deformacién para crear la nueva pose clave.

12. Repita los pasos anteriores hasta que la animacién haya terminado.

NOTA

Al manipular la articulacién de un hueso o hueso para juego, puede mantener pulsada la tecla
Alt para bloquear el angulo del hueso y solo acortar o alargar el hueso. También puede
mantener pulsada la tecla Ctrl (Windows/Linux) o 3§ (macOS) para romper la articulacién de su
cadena y transformarla en una nueva cadena de deformador independiente.
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Capitulo 14: Importacion de sonido y sincronizacion
de labios

~ \

Importacion de sonido

Si desea agregar sonido a la animacidn, es recomendable que edite y mezcle los archivos de sonido en un
software de edicién de sonido. Al tener pistas de sonido de larga duracién mezcladas previamente, se garantiza
que el sonido conserve su tiempo, mezcla y calidad si utiliza software de terceros para la postproduccién. Otra
buena préctica es mantener la pista de sonido separada en pistas de musica, efectos de sonido y personajes
para facilitar la sincronizacion de la animacidn con voces y sonidos. De lo contrario, es posible recortar los
efectos de sonido y ajustar su volumen directamente en Harmony cuando sea necesario.

Si crea el proyecto en Toon Boom Storyboard Pro, puede exportar todas las escenas del proyecto como escenas
separadas de Harmony. La pista de sonido del storyboard se cortard por escenay cada pieza se insertard en las
escenas exportadas, lo que permite ahorrar tiempo en la divisidon e importacién de la pista de sonido.

Harmony puede importar archivos de sonido .wav, .aiff y . mp3.

NOTA

La importacién de una pista de sonido mds larga que la escena no ampliard la longitud de esta
dltima. La reproduccién de sonido se detendr3 al final de la duracién de la escena.

Importacién de un archivo de sonido

1. Realice una de las siguientes acciones:
« En el menu superior, seleccione File > Import > Sound (Archivo > Importar > Sonido).

« Enlavista de carta de rodaje, haga clic con el botén derecho en cualquier parte del
drea de fotogramas y seleccione Import > Sounds (Importar > Sonidos).

o En el menu Xsheet (Carta de rodaje), seleccione File > Import > Sounds (Archivo >
Importar > Sonidos).

o En el mend Timeline (Linea de tiempo), seleccione Import > Sounds (Importar >
Sonidos).

Se abre el cuadro de didlogo Select Sound File (Seleccionar archivo de sonido).
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2. En el cuadro de didlogo Select Sound File (Seleccionar archivo de sonido), busque y seleccione un
archivo de sonido.

El archivo de sonido aparece como una capa en la vista de linea de tiempo. Su forma de onda se
muestra en la pista para ayudar a visualizar en qué fotogramas se producen los efectos de sonido de
la pista de sonido.

La pista de sonido también aparece como una columna en la vista de carta de rodaje, pero no
mostrara una forma de onda de forma predeterminada. Si lo desea, puede visualizar la forma de
onda de una columna de sonido haciendo clic con el botdn derecho en ella y seleccionando Sound
Display > Waveform (Visualizacién de sonido > Forma de onda).

Voice

voicewav

|

Deteccion automatica de sincronizacion de labios

La adicidn de la sincronizacion de labios a la animacién es fundamental para que parezca que los personajes
estdn vivos. Sin embargo, también es una parte especialmente pesada del proceso de animacion.

e W
~ \

Para solucionar este problema, Harmony proporciona una funcién de deteccién automatica de sincronizacion de
labios. Esta funcién analiza el contenido de una pista de sonido de la escena y asocia cada fonema que detecta
con una de las formas de boca de la siguiente carta de fonemas, que es una carta de fonemas estdndar de la
industria de la animacién.
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Boca
NOTA

Las letras asignadas a estas formas de boca son identificadores estdndar y NO se corresponden con
el sonido que se pretende producir.

Esta es una aproximacidn de los fonemas ingleses que cada forma de boca puede utilizar para representar:
e« A:m,b,p,h
e B:s,d,jik,t
e Cea
« D:AE
« E:0
e Fiu
o« G:f ph
« X:silencio, sonido indeterminado

Al realizar la deteccién automatica de sincronizacién de labios, Harmony no crea dibujos de boca. Simplemente
rellena la columna de dibujo de la capa de la boca del personaje con la sincronizacién de labios generada,
insertando la letra asociada con la forma de boca correcta en cada celda de la columna. Por lo tanto, para que la
deteccidén automatica de sincronizacion de labios funcione, la capa de la boca del personaje ya debe contener un
dibujo de boca para cada dibujo de la carta de fonemas, y estos dibujos deben tener el nombre de su letra
correspondiente.

Generacion de una deteccion de sonido para sincronizacion de labios mediante la vista
de propiedades de capa

1. Enlavista de linea de tiempo o de carta de rodaje, seleccione la capa de sonido.
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Las opciones para dicha capa aparecerdn en la vista de propiedades de capa.

2. Enlas propiedades de capa, haga clic en Detect (Detectar).

Harmony analiza los clips de sonido seleccionados y asigna una letra de sincronizacién de labios a
cada celda de sonido.

3. Hagaclicen el botén Map (Asignar) para abrir el cuadro de didlogo Lip-Sync Mapping (Asignacion
de sincronizacién de labios).

4. En el mend Destination Layer (Capa de destino), seleccione la capa que contiene las posiciones de la

boca para la pista de voz del personaje.
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NOTA

Si la capa seleccionada contiene simbolos, puede asignar la sincronizacion de labios
utilizando dibujos situados directamente en la capa o bien utilizar los fotogramas del
simbolo. En el campo Symbol Layer (Capa de simbolos), seleccione Don't Use Any
Symbol (No usar ninguin simbolo) si desea utilizar los dibujos o el simbolo deseado del
menu desplegable.

5. En la seccién Mapping (Asignacién), escriba el nombre del dibujo o los fotogramas del simbolo en el
campo situado a la derecha del fonema que representa. Si los dibujos ya tienen los nombres de las
letras del fonema, puede saltarse este paso.

6. Hagaclicen OK (Aceptar).
7. Enlabarra de herramientas de reproduccién, habilite la opcién #) Enable Sound (Habilitar sonido).

8. Pulse el botén » Play (Reproducir) en la barra de herramientas de reproduccién para ver y oir los
resultados en la vista de cdmara.

Si tiene que realizar ajustes a la sincronizacién de labios generada automaticamente, consulte
Animacién manual de sincronizacidn de labios en la pagina 130.

Animacion manual de sincronizacién de labios

Puede crear la sincronizacion de labios para la escena de forma manual seleccionando qué dibujo de boca debe
exponerse en cada fotograma del cuadro del didlogo de su personaje. Para este proceso, utilizard la funcién
Sound Scrubbing (Depuracién de sonido), que reproduce la parte de la pista de sonido en el fotograma actual
cada vez que mueva el cursor de la linea de tiempo, lo que permite identificar los fonemas que debe hacer
coincidir con la boca de su personaje. También se utilizara un dibujo de sustitucién para cambiar el dibujo de la
boca que se expone en cada fotograma.

Animacion de sincronizacion de labios utilizando la vista de linea de tiempo

1. Enlabarrade herramientas de reproduccidn, haga clic en el botén €S Sound Scrubbing
(Depuracion de sonido).

2. Enlavista delinea de tiempo, arrastre el cabezal de reproduccién rojo a lo largo de la forma de onda
de la capa de sonido.

3. Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en la
capa de formas de boca.

4. En la seccién Parameters (Parametros), y continuando en la capa de formas de boca, coloque el
cursor en la parte superior del nombre del dibujo (hormalmente una letra) hasta que cambie al
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puntero de intercambio ‘{5

5. Arrastre el cursor para ver la lista de los nombres de la forma de la boca y elija la que desee. El dibujo
actual se cambia automaticamente a la nueva seleccién.

Animacion de sincronizacién de labios utilizando la vista de libreria

1. Enlabarrade herramientas de reproduccién, haga clic el botén €S Sound Scrubbing (Depuracién
de sonido).

2. Enlavista de linea de tiempo, arrastre el cabezal de reproduccién rojo a lo largo de la forma de onda
de la capa de sonido.

3. Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en la
capa de formas de boca.

4. Enlaventana Drawing Substitution (Sustitucién de dibujo) de la vista de librerfa, arrastre el control
para elegir una forma de boca. El dibujo actual se intercambia por el de la ventana de
previsualizacién.
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Capitulo 15: Adicion de efectos a una escena

Al crear una escena, crear un rig de personaje o una vez que la animacion esté terminada, puede agregar
efectos, como desenfoques, brillos, sobras, filtros de color y de transparencia, asi como mejorar la calidad del
proyecto. Los efectos cambian la forma en la que las capas o grupos de capas se renderizan en la escena.

Acerca de los efectos

Los efectos son tipos de capas especiales que se pueden agregar a la estructura de la escena. Para que una capa
de efecto funcione, debe estar conectada como hija de un dibujo, grupo u otro efecto. Los efectos solo se aplican
al elemento al que estdn conectados. Esto proporciona flexibilidad a la hora de decidir a qué elementos de la
escena afecta un efecto.

Algunos efectos necesitan vincularse a otra capa, denominada capa de mate, que se usa para definir el drea a la
que deben afectar. Un buen ejemplo de ello es el efecto de tono, que se usa para agregar una sombra de una
forma determinada a una capa. De forma independiente, el efecto de tono no tienen ninglin impacto en el
dibujo al que estd conectado. Una vez combinado con una capa de mate, el efecto de tono usara la forma del
mate para aplicar una sombra al dibujo. Incluso si la forma del mate sale fuera de los contornos del dibujo, la
sombra solo se aplicard dentro de los contornos del dibujo.
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Una capa de mate es una capa de dibujo habitual que estd conectada a un efecto como su mate. El efecto toma
la forma del dibujo en la capa de mate para determinar el drea del dibujo a la que afecta. Los colores y detalles
de la capa de mate se ignoran mediante el efecto y solo se tiene en cuenta su forma.

En la vista de linea de tiempo, se debe crear un rig de un efecto como el hijo de una capa de dibujo o grupo al
que debe afectar.

Si el efecto puede usar una capa de mate, tendrd un pardmetro de mate al ampliar la lista de pardmetros. Puede
arrastrar y colocar la capa en la que desee usar un mate para el efecto en el pardmetro de mate del efecto para
vincularlos.

Si el efecto puede usar una capa de mate, tendrd un puerto de mate a su izquierda al que se puede conectar la
capa de mate.

Una vez que el efecto estd conectado, puede ajustar sus pardmetros seleccionandolo y, a continuacion,
ajustando sus pardmetros en la vista de propiedades de capa. También puede hacer doble clic en la capa para
abrir su cuadro de didlogo de propiedades de capa. Sise desea, incluso puede animar los pardmetros del efecto
convirtiendo sus valores a funciones.

Adicion de un efecto

En Harmony, puede agregar efectos seleccionando la capa o grupo al que desee agregar un efectoy, a
continuacidn, agregando el efecto a través del menud Add Layers (Agregar capas) de la vista de linea de tiempo.
A continuacidn, puede conseguir el efecto previsto ajustando los pardmetros en la vista de propiedades de capa
y conectandolos a una capa de mate, segun proceda.

Adicion de un efecto
1. En lavista de linea de tiempo, seleccione la capa en la que desee agregar un efecto.

2. Realice una de las siguientes acciones:

« En el menu superior, seleccione Insert > Effects (Insertar > Efectos) y seleccione el
efecto que desea agregar.
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o Enlabarrade herramientas Layers (Capas) situada encima de la lista de capas, haga
clicen el botén 4+, Add Layers (Agregar capas), seleccione Effects (Efectos) y, a
continuacion, seleccione el efecto que desee agregar.

« Haga clic con el botdn derecho en la capa, seleccione Insert > Effects (Insertar >
Efectos) y, a continuacidn, seleccione el efecto que desee agregar.

El efecto aparece en la vista de linea de tiempo, debajo de la capa seleccionada.

3. Enlavista de cdmara, haga clicen el botén Render View (Vista de render) para ver el fotograma

y el efecto actuales renderizados de la escena.

NOTA

El fondo aparecerd en negro de forma predeterminada. Para corregirlo, puede
agregar una capa de la carta de color en la parte inferior de la lista de capasy
cambiar su color en la vista de propiedades de capa.

4. En lavistadelinea de tiempo, haga doble clic en la capa del efecto para abrir la ventana Layer
Properties (Propiedades de capa). También puede seleccionar la capa del efecto y ver sus
propiedades en la vista de propiedades de capa.

Se abre la vista de propiedades de capa y muestra los pardmetros disponibles para el efecto
seleccionado.

5. Enlavista de propiedades de capa, ajuste los parametros del efecto segin sea necesario.

NOTA

Cada vez que realice un cambio, la vista de cdmara tendrd que actualizar la imagen
renderizada, lo cual puede provocar una ligera demora antes de que pueda observar el
efecto.
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6. La mayoria de los efectos no se reproduciran en tiempo real en Harmony. Para reproducir la escena
con los efectos finales, haga clicen el botén B Render and Play (Renderizar y reproducir) de la
barra de herramientas de reproduccién de la barra de herramientas de la vista de linea de tiempo.

NOTA

Una vez que haya establecido los pardmetros para el efecto, puede almacenarlo en la vista de
libreria como plantilla para poder reutilizarlo rdpidamente sin necesidad de volver a establecer
los pardmetros; consulte Creacidn y uso de plantillas en la pagina 162.

Adicion de un efecto con un mate

El siguiente tutorial muestra como usar el efecto de cuchilla con un mate. En Harmony, varios efectos usan mates
para determinar el drea de la imagen a la que afectan.

El efecto de cuchilla permite cortar una parte de una imagen. Para ello, debe conectarse al dibujo que se
pretende cortar, asi como a una capa de mate. La cuchilla adoptard la forma del dibujo de la capa de mate y
cortard esta forma de la capa de dibujo. Esto es especialmente Util si desea que un personaje desaparezca entre
un elemento de fondo, o si desea realizar un agujero en el centro de un personaje.

Aligual que todos los efectos que utilizan un mate, el efecto de cuchilla tiene un pardmetro Inverted (Invertido),
que estd deshabilitado de forma predeterminada. Cuando estd habilitado, la cuchilla tendrd el efecto contrario:
en lugar de cortar la forma del mate del dibujo, cortard todo lo que se encuentre fuera de la forma del mate del
dibujo, dejando solo las partes del dibujo que estén cubiertas por el mate.

Uso del efecto de cuchilla

1. Seleccione una capa de dibujo.
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2. Realice una de las siguientes acciones:

o Enlabarrade herramientas sobre la lista de capas en la vista de linea de tiempo, haga clicen
el botén Add Layer (Agregar capa) =,y seleccione Effects > Cutter (Efectos > Cuchilla).

« Haga clic con el botén derecho en la capa y seleccione Insert > Effects > Cutter (Insertar >
Efectos > Cuchilla).

El efecto de cuchilla se crea como capa hija de la capa seleccionada.

1. Enlabarrade herramientas sobre la lista de capas en la vista de linea de tiempo, haga clicen %%
Add Drawing Layer (Agregar capa de dibujo).

2. En el cuadro de didlogo Add Drawing Layer (Agregar capa de dibujo), asigne a la nueva capa d
dibujo un nombre relevante para una capa de mate, como "Dibujo de mate" y, a continuacién, haga
clicen Add and Close (Agregary cerrar).

3. Enla nueva capa de dibujo de mate, dibuje un mate para el efecto. El mate puede ser una forma
simple, pero se debe rellenar con un color, ya que solo se tendrdn en cuenta las partes del mate que
sean opacas.

NOTA

Los mates también pueden tener dreas semitransparentes. Las dreas del dibujo
cubiertas por dreas semitransparentes del mate se ven parcialmente afectadas por el
efecto.
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4. En lavista de linea de tiempo, haga clic en el botén + Expand (Expandir) situado a la derecha de la

capa Cutter (Cuchilla).

5. Arrastre y coloque la capa de mate junto al campo Matte (Mate) de la capa Cutter (Cuchilla), debajo
de la columna Parameters (Pardmetros).

La capa de dibujo de mate se convierte en el mate de la capa de cuchilla. En este punto, las dreas de
la ilustracidn que se cruzan con lailustracion de la capa de dibujo de mate estan ocultas.

6. Sidesea invertir el efecto de cuchilla, para que la ilustracién que se cruza con lailustracién de la capa
de mate sea visible y todo lo demds esté oculto, haga doble clic en la capa Cutter (Cuchilla) (pero no
en sunombre) para abrir su cuadro de didlogo de propiedades de capay, a continuacién, marque el
pardmetro Inverted (Invertido).

Otros dos ejemplos de efectos que funcionan con mates son los efectos de tono y resaltado. El efecto de tono
aplica una sombra a su dibujo basada en su mate, mientras que el efecto de resaltado aplica un resaltado a un
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dibujo basado en un mate. Estos efectos no se aplican fuera de los dibujos a los que estdn conectados, de modo
que solo tiene que dibujar los resaltados y la sombra del personaje en las capas de mate sin preocuparse por
dibujar fuera del trazado.

La adicidn de estos efectos a un dibujo funciona exactamente igual que la adicién de una cuchilla a un dibuijo,
salvo que tienen pardmetros adicionales para configurar el color, la intensidad y el renderizado del efecto.

Animacion de un efecto

Es posible que necesite animar algunos efectos para obtener los resultados esperados. Por ejemplo, puede
desear que el radio de un efecto de brillo aumente y disminuya lentamente para hacer que vibre a lo largo de
una escena, o puede desear que la transparencia de un efecto de transparencia aumente de 0 % a 100 % para
hacer desaparecer un dibujo.

Casi todos los pardmetros numéricos de un efecto se pueden unir a una funcién. Una funcién permite definir un
pardmetro para distintos valores en diferentes puntos de la escena afnadiéndole fotogramas clave y definiendo
cada fotograma clave en un valor especifico. Entre fotogramas clave, el valor del pardmetro avanzard desde el
valor del fotograma clave anterior al valor del siguiente fotograma clave. Las capas de dibujo se animan
asociando sus coordenadas a funciones. Del mismo modo, los efectos se pueden animar asociando sus
pardmetros a funciones.

Algunos pardmetros de efectos se pueden animar directamente en la vista de linea de tiempo, pero no todos. Al
expandir los pardmetros de un efecto en la vista de linea de tiempo, algunos de sus pardmetros pueden estar
ocultos para evitar saturar la vista de linea de tiempo. Puede animar esos pardmetros desde la vista de
propiedades de capa o el cuadro de didlogo de propiedades de capa, que muestra todos los pardmetros de una
capa.
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Animacién de un parametro de efecto en la vista de linea de tiempo

1. Enlavista de linea de tiempo, localice el efecto que desea animar y haga clic en el botén 4 Expand
(Expandir) situado a la derecha de su nombre.

Aparece en la vista de linea de tiempo la lista de pardmetros que muestra los parametros de efectos
disponibles.
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2. En el drea derecha de la vista de linea de tiempo, en la misma fila que el pardmetro que desee
animar, seleccione el fotograma en el que desee crear el primer fotograma clave de animacién para el
efecto.

3. Cree un fotograma clave realizando una de las siguientes acciones:

« Enlabarra de herramientas de linea de tiempo, haga clicen el botén & Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.
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4. En el drea delaizquierda de la vista de linea de tiempo, debajo de la columna Parameters
(Pardmetros), ajuste el valor del pardmetro para este fotograma clave realizando una de las
siguientes acciones:

« Haga clicy mantenga pulsado el valor del pardmetro. A continuacién, arrdstrelo hacia la
izquierda para reducir su valor o hacia la derecha para aumentarlo.

« Hagadlicen el valor del parametro. Aparecerd un campo de texto. Escriba el nuevo valor del
pardmetroy pulse Entrar.

5. En el drea derecha de la vista de linea de tiempo, haga clic en el fotograma en el que desee crear el
segundo fotograma clave de animacidén para el efecto.

ro=al

6. Cree el segundo fotograma clave para la animacidn del efecto realizando una de las siguientes
acciones:

« Enlabarra de herramientas de linea de tiempo, haga clicen el botén & Add Keyframe
(Agregar fotograma clave).

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).

e Pulse F6.

7. Enla columna Parameters (Parametros), ajuste el valor del pardmetro en el fotograma clave actual.
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8. Repita los pasos para crear tantos fotogramas clave de animacién para el efecto como sea necesario.

9. Para ajustar el tiempo entre los fotogramas clave de la animacidn, seleccione el primer fotograma
clave.

10. Enlabarra de herramientas de linea de tiempo, haga clic en el botén <~ Set Ease for Multiple
Parameters (Definir aceleracién para varios pardmetros).

Aparece el cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracién para varios
parametros). El grafico de funciones de este cuadro de didlogo se centrard en el primer o fotograma
clave de la animacidn, que debe tener un controlador de la = curva Bézier al lado apuntando hacia la

Segundo
fotograma clave

derecha.

S EEEE@E

Primer
fotograma clave

Controlador de
curva Bézier

!

App

11. Haga clicen el controlador de la = curva Bézier y arrdstrelo hacia la derecha, en cualquier angulo,
para ajustar la aceleracién gradual de la animacién.

12. Haga clicen Apply/Next (Aplicar/siguiente).
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El cuadro de didlogo Set Ease For Multiple Parameters (Definir aceleracién para varios parametros)

se centrard en el segundo fotograma clave. Si este es el Ultimo fotograma clave de la animacidn, solo
tendrd un controlador de la curva Bézier apuntando hacia la izquierda. Si hay mas fotogramas clave
de animacién después de este, tendra dos controladores de la curva Bézier, uno apuntando en cada

direccion.

13. Haga clicen el controlador izquierdo de la - curva Bézier y arrastrelo hacia la izquierda, en cualquier
angulo, para ajustar la desaceleracién gradual de la animacién entre el fotograma clave anterior y el
fotograma clave actual.

14. Sihay un controlador de la = curva Bézier apuntando hacia la derecha, haga clicen él y arrdstrelo
hacia la derecha, en cualquier angulo, para ajustar la aceleracién gradual de la animacién entre el
fotograma clave actual y el siguiente fotograma clave.
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15. Repita los pasos anteriores hasta que el tiempo de la animacidn se ajuste a lo largo de toda la escena.

Animacidn de un efecto en el cuadro de didlogo de propiedades de capa

1. Abralas propiedades de capa del efecto realizando una de las siguientes acciones:

o Agregue la vista de propiedades de capa al espacio de trabajo y seleccione el efecto en la
vista de linea de tiempo.

« Enlavista de linea de tiempo, haga doble clic en la capa del efecto, pero no en sunombre.

2. Enlas propiedades de capa del efecto, localice el pardmetro que desea animar y haga clic en el botdn
S Function (Funcidn) situado a su derecha.

El campo de entrada del pardmetro se atenuara. Esto se debe a que no puede editar un pardmetro
directamente una vez conectado a una funcién. El campo indicard el nombre de la funcién que se
cred para él en este formato:

Nombre de capa: Nombre de funcién: Valor en fotograma actual
3. Haga clicde nuevo en el botdn Function (Funcién) del pardmetro.

Se abre el cuadro de didlogo Bezier Editor (Editor de Bézier).
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Cursor de
fotograma actual
Gréfico de
funciones

Este cuadro de didlogo permitird animar la funcidn. El gréfico de funciones de la parte inferior sirve
para representar los valores de la funcién a lo largo de cada fotograma de la escena.

4. En el gréfico de funciones, haga clicy arrastre el cursor rojo ' para moverlo al fotograma donde
desea crear el primer fotograma clave de animacién.

5. Haga clicen el botén ¢ Add Keyframe (Agregar fotograma clave) para crear el primer fotograma

clave de animacidn para el efecto.

Se crea un fotograma clave o y debe ser visible en el gréfico de funciones. Si no se ve, es porque el
gréfico de funciones no estd colocado para incluir el fotograma clave en su fotograma. Para mover el
gréfico de funciones con el fin de ver el fotograma clave de la funcién, haga clic en el botén ©) Reset
View (Restablecer vista) o @ Reset View Vertically (Restablecer vista vertical).
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6. Ajuste el valor del pardmetro al fotograma actual realizando una de las siguientes acciones:

« En el campo Value (Valor) sobre el gréfico de funciones, escriba el valor deseado para el
pardmetro.

« En el gréfico de funciones, haga clicy arrastre el o fotograma clave y muévalo hacia arriba
para aumentar su valor o hacia abajo para disminuirlo.

:Q’. SUGERENCIA

Si desea establecer el fotograma clave en un valor que estd fuera del fotograma
del gréfico de funciones, puede pulsar la tecla 1 para alejarse. También puede
pulsar la tecla 2 para volver a acercarse.
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7. Hagaclicy arrastre el cursor rojo para moverlo al fotograma donde desea crear el segundo
fotograma clave de animacidn.

8. Hagaclicen el botén o Add Keyframe (Agregar fotograma clave) para crear el segundo fotograma
clave de animacion para el efecto.

9. Ajuste el valor del pardmetro al fotograma actual realizando una de las siguientes acciones:

o En el campo Value (Valor) sobre el gréfico de funciones, escriba el valor deseado para el
pardametro.

« En el gréfico de funciones, haga clicy arrastre el o fotograma clave y muévalo hacia arriba
para aumentar su valor o hacia abajo para disminuirlo.
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10. Sidesea ajustar el tiempo de la animacién entre el primer y el segundo fotograma clave, haga lo
siguiente:

« Haga dlicy arrastre el controlador de la = curva Bézier del primer fotograma clave hacia la
derecha, en cualquier direccidn, para que afecte a la aceleracién gradual de la animacién.

« Haga clicy arrastre el controlador de la <= curva Bézier del segundo fotograma clave hacia la
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izquierda, en cualquier direccidn, para que afecte a la desaceleracién gradual de la animacion.

11. Repita estos pasos hasta que haya creado y sincronizado los fotogramas clave de animacién
necesarios para animar el efecto.

Creacion de un efecto basado en un personaje animado

En el siguiente tutorial se demuestra cdmo combinar efectos con otras funciones de Harmony para crear
facilmente una sombra paralela para un personaje animado. Siguiendo estos pasos, puede crear una sombra
paralela que seguird automaticamente la animacién del personaje, incluso si después cambia la animacion.

Creacion de una sombra paralela para un personaje animado

1. En lavista de linea de tiempo, seleccione todas las capas que forman el rig de personaje. Si el
personaje estd bajo un peg maestro, también funcionara si selecciona el peg maestro.

rno=am
o
o
o

o
o
o
o

2. Asegurese de que el rig de personaje se encuentre en un grupo. De no ser asf, haga clic con el botén
derecho en la seleccidn vy, a continuacidn, seleccione Group Selection (Agrupar seleccidn).
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3. Una vez seleccionado el personaje en la vista de linea de tiempo, cree un clon del personaje
realizando una de las siguientes acciones:

« Haga clic con el botén derecho en la seleccién vy, a continuacidn, seleccione Clone
Selected Layers: Drawings and Timing (Clonar capas seleccionadas: Dibujos y tiempo).

« En el menu superior, seleccione Edit > Clone: Drawings and Timing
(Editar > Clonar: Dibujos y tiempo).

ro=al
L]

NOTA

Al contrario que un duplicado, una capa clonada siempre tiene el mismo tiempoy la
misma exposicién que su capa de origen, incluso si su capa de origen se cambia mas
tarde. Por lo tanto, puede cambiar la animacién del personaje y la animacién del
personaje clonado se actualizard automaticamente con estos cambios.

4. Agregue un efecto de sombra al grupo realizando una de las siguientes acciones.

« Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clicen +,
Add Layers (Agregar capas) y seleccione Effects > Shadow (Efectos > Sombra).

« Haga clic con el botén derecho en la seleccidn vy, a continuacidn, seleccione Insert >
Effects > Shadow (Insertar > Efectos > Sombra).

5. En lavista de linea de tiempo, seleccione la capa raiz del clon del personaje.

6. Cree un peg padre para el clon realizando una de las siguientes acciones:
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o Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clicen el
botén Add Peg (Agregar peg) (% .

o Pulse Ctrl + P (Windows/Linux) o 38 + P (macOS).

En la vista de linea de tiempo, seleccione el peg padre del clon.

En la barra de herramientas de herramientas, seleccione la herramienta .} Transform
(Transformar).

En la vista de cdmara, escale y sesgue el clon de modo que parezca una sombra difuminada.

150



Gufa deintroduccién de Harmony 16.0 Advanced

151



Capitulo 16: Uso de gufas de dibujo

Capitulo 16: Uso de guias de dibujo

Cuando tenga que dibujar fondos u objetos con numerosas lineas rectas, dngulos en escuadra y perspectivas,
puede usar las guias de dibujo para que le ayuden. Las guias agregan una linea de horizonte, asi como puntos
de fuga al espacio del dibujo, que se pueden mover para adaptar las necesidades de la escena y bloquean las
herramientas de dibujo para que siempre dibujen lineas rectas, bien desde uno de los puntos de fuga, o bien

hacia el eje horizontal o vertical de la gufa.
Harmony admite los siguientes tipos de gufas de dibujo:

« Laguiade cuadricula cuadrada simplemente le ayuda a dibujar en los ejes horizontales y verticales, que

son relativos a la linea del horizonte.

« Laguiade perspectiva con 1 punto le ayuda a dibujar Iineas procedentes de un Unico punto de fuga, que
se sitla en el centro del horizonte de forma predeterminada. También le ayuda a dibujar a lo largo de los
ejes horizontales y verticales. Esto puede ayudar a crear fondos realistas con edificios, paredes y objetos

situados enfrente de la cdmara.

« Laguiade perspectiva con 2 puntos le ayuda a dibujar lineas procedentes de uno de los dos puntos de
fuga situados a laizquierda y a la derecha del espacio de dibujo. Esto puede ayudar a crear fondos
realistas con edificios, paredesy objetos situados en un dngulo de la cdmara.
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« Laguiade perspectiva con 3 puntos le ayuda a dibujar lineas procedentes de uno de los 3 puntos de
fuga: dos puntos de fuga horizontales situados a la izquierda y a la derecha del espacio de dibujo, y un
punto de fuga vertical situado debajo o encima del espacio de dibujo. Esto puede ayudarle a crear fondos
realistas desde un dngulo bajo o alto. La guia de perspectiva con 3 puntos tiene dos valores predefinidos:
el plano cenital y el plano nadir, que se pueden utilizar para perspectivas de angulo alto y de dngulo bajo,

respectivamente.

Para usar una guia de dibujo, en primer lugar debe agregarla a la lista de guias de la escena.

Adicién de una guia de dibujo a la escena

1. En el menu superior, seleccione Windows > Guides (Ventanas > Guias) para agregar la vista de

guias al espacio de trabajo actual.

2. Enla vista de gufas, seleccione el botén == New Guide (Nueva gufa) y elija uno de los siguientes

tipos de guias:
. Square Grid (Cuadricula cuadrada)
o 1=} 1-Point Perspective (Perspectiva con 1 punto)
o <P 2-Point Perspective (Perspectiva con 2 puntos)

' 3-Point Perspective (Perspectiva con 3 puntos) (plano cenital)
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. é 3-Point Perspective (Perspectiva con 3 puntos) (plano nadir)

La nueva guia aparece en la lista de la vista de gufas.

Number of Lines

3. Paraagregar otra guia, repita el paso anterior.

Edicion de una guia de dibujo

1. En lavista de linea de tiempo o de carta de rodaje, seleccione un dibujo o una celda vacia, y cree un
nuevo dibujo realizando una de las siguientes acciones:

« Haga clic con el botén derecho en la celda y seleccione Drawing > Create Empty Drawing
(Dibujo > Crear dibujo vacio).

o Pulse Alt + Mayus + R

2. Enlabarrade herramientas de herramientas, seleccione la herramienta »” Brush (Pincel), £ Pencil
(Lépiz), (= Stroke (Linea vectorial transparente) o ./ Line (Linea).

3. Enlavista de guias, seleccione una guia para convertirla en la guia activa.

Una vez que la guia esté activa, su linea del horizonte y sus puntos de fuga aparecen en el drea de
dibujo.
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4. En lavista de guias, aseglrese de que la opcién [=n Lock Guide (Bloquear guia) esté deshabilitada.
Con ello garantiza que puede editar la guia activa.

5. En el drea de dibujo, aleje el zoom hasta que todos los puntos de fuga sean visibles (si fuera
necesario).

6. En el drea de dibujo, agarre el horizonte o un punto de fuga y muévalo hasta la ubicacién deseada.

Al usar la guia de cuadricula cuadrada o la de perspectiva con 1 punto, el angulo del horizonte se
puede modificar al manipular la propia linea del horizonte.

Al usar la guia de perspectiva con 2 puntos o la de con 3 puntos, el angulo del horizonte se puede
modificar al manipular uno de los dos puntos de fuga del horizonte.
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Al ajustar la linea del horizonte, puede mantener pulsada la tecla MayUs para que la linea del
horizonte se ajuste a cada 15 grados. Asi es facil mantener un horizonte totalmente horizontal.

NOTA

Cada modificacidn a una gufa se puede deshacer con el comando Undo (Deshacer).

Dibujo con guias de dibujo

1. En lavista de linea de tiempo o de carta de rodaje, seleccione un dibujo o una celda vacia, y cree un
nuevo dibujo realizando una de las siguientes acciones:

« Haga clic con el botén derecho en la celda y seleccione Drawing > Create Empty Drawing
(Dibujo > Crear dibujo vacio).

o Pulse Alt + Mayus + R

2. Enlabarrade herramientas de herramientas, seleccione la herramienta s~ Brush (Pincel), £ Pencil
(Lépiz), (~ Stroke (Linea vectorial transparente) o ./ Line (Linea).

3. Enlavista de guias, seleccione la guia que desee usar.

4. En el drea de dibujo, dibuje un trazo con la herramienta de dibujo actual. Desde el gesto inicial, la
herramienta se bloquea en uno de los ejes de la guia y lo fuerza a dibujar una linea recta que siga al
eje.
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Capitulo 17: Creaciéon de un multiplano

En la accidn en vivo, cuando la cdmara se mueve alrededor de una escena, parecerd que los objetos cercanos a la
camara se desplazan a una distancia mayor que los objetos alejados de la misma. En la animacién 2D, se puede

conseguir un efecto similar creando un multiplano.

En Harmony, puede configurar facilmente un multiplano creando un fondo sobre varias capas, extendiéndolas
en el eje Z para agregar profundidad y moviendo la cdmara por el entorno resultante para crear una ilusién de

perspectiva impresionante.

En el siguiente ejemplo, el fondo se compone de 6 capas diferentes, y cada una representa un objeto que se
encuentra a una distancia diferente de la cdmara. A la izquierda, puede ver cémo se sitla cada objeto en
relacién con la cdmara, como si estuviera mirandolos desde un lado. A la derecha, puede ver cémo se sitlan las
capas en relacién entre si como si estuviera mirando la escena desde una esquina. A continuacién, puede ver la

escena desde el punto de vista de la cdmara.
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Mediante la herramienta Maintain Size (Mantener tamafo), puede convertir facilmente un fondo multicapa
normal en un multiplano. Esta herramienta permite mover una capa mas cerca o mas lejos de la cdmara mientras
se ajusta automdticamente el tamafio de la capa proporcionalmente a su distancia de la cdmara, conservando su
tamafo aparente desde el punto de vista de la cdmara. Por lo tanto, no tiene que preocuparse por el tamafio y
la posicidn de las capas al disefiar el fondo.

En una nueva escena de Harmony, dibuje los distintos elementos de un fondo en capas separadas. Siga los

pasos que se muestran a continuacion para convertir el fondo en un multiplano.

Configuracion de un multiplano con la herramienta Maintain Size (Mantener tamaio)

1. Aseglrese de que la opcién No Z Dragging (Sin arrastre de eje Z) del menu superior Animation
(Animacidn) esté deshabilitada.

2. Realice una de las siguientes acciones:

o Enlabarrade herramientas Advanced Animation (Animacién avanzada), seleccione la
herramienta 53 Maintain Size (Mantener tamafio).

« En el menu superior, seleccione Animation > Tools > Maintain Size (Animacién >
Herramientas > Mantener tamano).

159



Capitulo 17: Creacién de un multiplano

o Pulse Alt + 6.

3. Enlavista lateral o superior, seleccione una de las capas de la seccién de imdgenes en miniatura.
También puede seleccionar una capa en la vista de linea de tiempo.

La capa seleccionada se resalta en las vistas superior, lateral y de cdmara.

El elemento se moverd en el eje Z de la escena, pero mantendrd el mismo tamafio aparente en la
vista de cdmara.

Puede ver el multiplano desde distintos puntos de vista mediante la vista de perspectiva.

Visualizacién del multiplano en la vista de perspectiva

1. Habilite la vista de perspectiva realizando una de las siguientes acciones:

« Hagaclicen el botén Add view (Agregar vista) situado junto a las pestanas de las
vistas de cdmara y de dibujo y seleccione Perspective (Perspectiva).

o En el menu superior, seleccione Windows > Perspective (Ventanas > Perspectiva).

2. Pararotar la vista de perspectiva en las 3 dimensiones, mantenga pulsado Ctrl + Mayus
(Windows/Linux) o & + mayusculas (macOS) y, a continuacidn, haga clicy arrastre.
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Capitulo 18: Creacidon y uso de plantillas

Puede crear una plantilla a partir de una capa o de celdas. Puede almacenar como una plantilla cualquier
elemento disponible en la vista de linea de tiempo.

Creacion de una plantilla

Creacion de una plantilla

1. Enlavista de linea de tiempo, seleccione varias celdas o capas.

Puede crear una plantilla a partir de una jerarquia de capas entera contrayendo la jerarquia y
seleccionando su capa raiz. Esto puede ser (til para crear plantillas basadas en rigs de personajes o
fondos de escena.

2. Enlavista de librerfa, seleccione una carpeta para almacenar la plantilla. De forma predeterminada,
tendrd una libreria denominada Libreria de Harmony Advanced almacenada en el ordenador, en la
subcarpeta Librerfa de Toon Boom Harmony Advanced de la carpeta Documentos.

3. Silacarpeta de libreria estd blogueada, haga clic con el botén derecho y seleccione Right to
Modify (Derecho para modificar).

4. Arrastre la seleccidn a la carpeta de la libreria elegida.

Library  ==[%

[ AW ]

5. En el cuadro de didlogo Rename (Cambiar nombre), asigne un nombre a la nueva plantilla.

6. Hagaclicen OK (Aceptar).
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_‘Q'. SUGERENCIA

Para cambiar el nombre de una plantilla una vez creada, haga clic con el botén derecho sobre ellay
seleccione Rename (Cambiar nombre).

Importacion de una plantilla

Importacién de una plantilla

1. Enlavista de libreria, seleccione la plantilla que desea importar.

2. Arrastre la plantilla seleccionada a la vista de cdmara o a la izquierda de la vista de linea de tiempo.

Si coloca la plantilla en la vista de cdmara, sus capas se agregardn en la parte superior de la lista de
capas. Si coloca una plantilla en la lista de capas de la vista de linea de tiempo, se insertara entre las
capas en las que la colocd.

Si la plantilla tiene la misma estructura de capas que una parte de la escena, puede colocarla
directamente en los fotogramas del lado derecho de la vista de linea de tiempo. En lugar de insertar
nuevas capas en la escena, esta accién reemplazarad los dibujos y los fotogramas clave de la escena
por los de la plantilla. Esto es Util para importar plantillas de pose o animacidn para los personajes
gue ya se encuentran en la escena.
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Library | =%

[ATWI]

Timeline  ==[%

+ %

K
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Capitulo 19: Exportacion de una pelicula

A través del cuadro de didlogo Export Movie (Exportar pelicula), puede exportar la animacién como un archivo
de video. Harmony exportard toda la escena en su resolucién completa de forma predeterminada. Silo prefiere,
puede elegir exportar solo un rango de fotogramas especifico en la escena o exportarlo en una resolucién mas
pequenfa, lo cual puede ser Util si necesita ahorrar tiempo o espacio en disco.

Si tiene requisitos especificos para la calidad y el tamafio de los archivos de video exportados, puede utilizar el
cuadro de didlogo Movie Options (Opciones de pelicula) para configurar la compresidn del video y del sonido. Si
va a exportar una pelicula de QuickTime, tiene acceso a todos los cédecs y configuraciones de compresién
disponibles en la interfaz de QuickTime.

Exportacion de un archivo de pelicula

1. En el menu superior, seleccione File > Export > Movie (Archivo > Exportar > Pelicula).

Se abre el cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime).

2. En el mentdesplegable Video Format (Formato de video), seleccione el formato deseado para el

archivo de pelicula:
o Quick Time Movie (*.mov): disponible en Windows, macOS y GNU/Linux.

o Windows Media Video (*.wmv): disponible solamente en Windows.
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NOTA

En Windows y macOS, se debe instalar QuickTime de Apple para exportar

peliculas de QuickTime.

3. Haga clic en Browse (Examinar) para seleccionar la ubicacién y el nombre de archivo del archivo de
pelicula exportado.

4. Hagaclicen OK (Aceptar).

5. En la seccién Export Range (Rango de exportacién), decida si desea exportar toda la escena (All
(Todo)) o un intervalo de fotogramas especifico. Si decide lo Ultimo, introduzca un rango de
fotogramas.

6. Enla seccién Resolution (Resolucidn), seleccione una de las siguientes opciones en el mend:
« Una relacién de resolucion preferida.

o Custom (Personalizado): Habilita los campos Width (Ancho) y Height (Altura) para
gue pueda introducir un tamafo especifico.

7. Hagaclicen OK (Aceptar).

8. En el cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime), haga clic en
OK (Aceptar).

Aparece una barra de progreso.
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Capitulo 19: Exportacién de una pelicula

9. Despldcese ala ubicacion en el ordenador en la que ha exportado la pelicula y haga doble clicen ella
para verla en el reproductor de video.
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3D estereoscépico

Capacidad de crear imagenes estéreo que, cuando se animan y se ven a través de gafas con
obturador activo 3D o mediante gafas con una lente roja y otra azul, se mostraran como una
pelicula tridimensional.

canal alfa | Canal de imagen que contiene informacidn de transparencia. De partida, una imagen tiene
tres canales: rojo, verde y azul (RGB). El canal alfa es el cuarto canal (A). El mate, o
informacidn de transparencia, se almacena en este cuarto canal. Una imagen sin canal alfa
siempre es opaca.
animatica | Pelicula con sonido que se desarrolla a partir del storyboard. El panel de storyboard queda
expuesto durante el transcurso de la escenay, en ocasiones, los personajes se colocan en
una trayectoria para indicar movimiento. Los movimientos de cdmara también estan
animados. La animdtica se utiliza para determinar el ritmo de un proyecto y proporciona una
buena vision general del proyecto antes de comenzar la produccidn.
animacién | Simulacién de movimiento creada mostrando una serie de imagenes o fotogramas.
anime | Estilo de animacidn conocido por su aspecto siniestro y oscuro, popular en Japdn.
arco | La accién no suele producirse de forma directa, sino que mds bien se suele desplegar en lo

que los narradores denominan un arco. El propésito de un arco de historia es mover un
personaje o situacidn de un estado o escenario al siguiente.

proporcién

Relacién entre las dimensiones de ancho vy altura de una escena, fotograma o formato de
pelicula. La proporcidn en televisién es de 4:3 y la proporcién panoradmica de 16:9.

alimentador de papel
automdtico

Método automatizado de introducir dibujos en un escéner en el que hay varios dibujos
apilados en un alimentador de hojas. Cuando se activa el escdner, los dibujos se digitalizan
de forma consecutiva, sin ninguna otra intervenciéon del usuario.

deteccién automatica de
sincronizacién de labios

Asignacién automédtica de dibujos en un elemento a la carta de fonemas generada para un
sonido. Puede ahorrar tiempo al sincronizar los labios una pista de voz.

eje | Lineaimaginaria alrededor de la cual rota un objeto.

Para gréficos 2D, hay dos gjes: X (horizontal) e Y (vertical).
Para gréficos 3D, hay tres ejes: X (horizontal), Y (vertical) y Z (profundidad).
En animaciones que rotan constantemente, el elemento de eje especifica alrededor de qué eje
rota el objeto. Un ndmero negativo provoca que una animacién rote en sentido contrario a
las agujas del reloj, mientras que un ndmero positivo hace que una animacién rote a la
derecha.

fondo | Parte de una escena que estd mas alejada hacia la parte posterior. El fondo es la ilustracidn, o

decoracidn, sobre la que se produce la animacidn.

curva Bézier

Método para definir lineas curvas inventado por el matematico francés Pierre Bézier. Una
curva Bézier es una curva matemdtica o paramétrica. Las curvas Bézier utilizan al menos tres
puntos para definir una curva.

mapa de bits

Imagen compuesta por pixeles con una Unica resolucién (tamafio). Si se amplia demasiado,

170



Guia de introduccién de Harmony 16.0 Advanced

Término

Definicién

perdera definicién y comenzardn a aparecer pixeles individuales. A esto se le conoce como
pixelacién.

Los archivos de imagen de mapa de bits se definen como una malla rectangular estandar de
pixeles individuales. Cada pixel individual contiene un valor que representa un color
especifico.

descomposicion

En animacién Cut-out, la descomposicidn es la acciéon de descomponer un personaje en
trozos para crear una marioneta con articulaciones. Para descomponer un personaje, el
artista corta partes, como las manos y los brazos, del modelo del personaje y las pega en
capas independientes. A continuacion, las articulaciones se fijan y se definen los pivotes.

En la animacidn tradicional, una descomposicién es una pose de animacién que
normalmente se encuentra entre dos poses clave. Las poses clave son las poses principales
de una animacién y las descomposiciones son poses secundarias que ayudan a describir el
movimiento y la curva de rotacién (normalmente denominada arco).

vibracién de camara

La vibracién de cdmara se produce en una escena cuando la cdmara se mueve ligeramente y
rdpidamente en varias direcciones. Este movimiento da la impresién de impacto, vibracién o,
por ejemplo, baches en la carretera.

cuadro de texto

Campo de texto que contiene informacién de didlogo, efectos, sonido o slugging en un
storyboard.

celda

En la animacidn tradicional, una celda (también denominada celuloide) es una hoja
transparente en la que la animacidn se tinta y se pinta antes de enviarla a la cdmara. El
trazado de la imagen se dibuja en |la parte delantera de la celday, a continuacién, se colorea
por la parte trasera.

disefio del personaje

Cada personaje de una pelicula animada se dibuja desde varios dngulos en formato de estilo
pdster denominado hoja de modelo, que sirve como referencia para los animadores.

aberracién cromatica

En dptica, una aberracién cromatica (CA), acromatismo o distorsién cromdtica, es un tipo de
distorsién en el que una lente no puede enfocar todos los colores en el mismo punto de
convergencia.

clean up

Una vez que los bocetos se han evaluado y aprobado, se quita todo el ruido de laimagen
(Iineas sobrantes, notas, etc.) para crear dibujos finales que se pueden tintar, pintar y filmar.
El proceso de clean up hace referencia al trazado de una linea limpia sobre un boceto para
conseguir la versidn final o a la eliminacidn de la suciedad y las lineas adicionales que han
quedado tras el proceso de digitalizacidn.

CMYK

Acrénimo en inglés de cian, magenta, amarillo y negro. Estos colores forman el modelo
estandar utilizado en un proceso denominado impresidn offset.

carta de color

Una carta de color es una tarjeta que contiene un color sélido con el mismo tamafio que la
cdmara. La carta de color rellena el fondo con un color sélido cuando no se haincluido
ninguna imagen de fondo.

modelo de color

Disefio de color oficial que se debe utilizar para pintar la animacién. Un modelo es el disefio
de personaje, prop o fondo definitivo que cada artista debe seguir para la produccidn.

circulo cromdtico

Visualizacién del espectro de colores en forma de circulo.
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composicién

La composicidn es la accién de incorporar todos los elementos de una escena para crear el
resultado final antes del renderizado. Por ejemplo, el artista de la composicién importard
todas las secuencias, el fondo, las superposiciones y las subcapas de la animacidn en la
escena vy los colocara correctamente. A continuacidn, el artista definird el encuadre de cdmara
y lo animard en caso necesario. Por Ultimo, el animador creard todos los efectos generados
por ordenador para el proyecto.

fundido encadenado

Efecto utilizado para fundir dos escenas, una dentro de la otra.

corte

Transicién directa entre dos escenas. Cuando se utiliza un corte, no se insertan efectos de
transicidn para pasar de una escena a la siguiente. La primera escena termina y la segunda
comienza inmediatamente.

animacién Cut-out

El proceso conocido como animacién Cut-out es la accién de animar personajes compuestos
por varias piezas moviéndolos de fotograma en fotograma. La animacién Cut-out se puede
generar por ordenador o realizarse del modo tradicional utilizando papel.

ciclo | Grupo de imdgenes que forman juntas una accién, como caminar. Un ciclo es una accién
repetida como un bucle durante un periodo de tiempo. Puede ser una serie de dibujos o
fotogramas clave animados.
didlogo | Texto hablado por un personaje en una pelicula o animacidén.

carta de rodaje

La utilizan los animadores, directores y otros miembros del equipo para trazar la secuencia y
el tiempo de las imagenes, el didlogo, los efectos de sonido, las pistas de sonido y los
movimientos de cdmara. Conocida también como carta de exposicidn.

usar carta de rodaje

Asignar un dibujo determinado a un rango de fotogramas.

paso con doble bote

En los fotogramas clave y las posiciones de paso de un paso con doble bote, el cuerpo es
menor que una linea de referencia dibujada en posicidn vertical. Durante los intercalados, el
cuerpo estd situado sobre esta linea, ofreciendo asi un aspecto de rebote.

DPI

Siglas en inglés para puntos por pulgada, que representa la medida estdndar de resolucién
para impresoras computarizadas. En ocasiones se aplica a pantallas, en cuyo caso es mas
exacto denominarlo pixeles por pulgada. En cualquier caso, el punto es el elemento
diferenciado mds pequefio que forma la imagen.

aceleracién

En animacidn, la velocidad es la aceleracidon y la desaceleracion de un movimiento. Puede ser
un movimiento creado mediante una curva de funcién o una serie de dibujos animados.
Otros términos comunes para aceleracién-gradual y desaceleracién-gradual son aceleracion
y desaceleracién.

aceleracién-gradual

Aceleracion gradual en la accién. Conocida también como aceleracidn.

desaceleracién-gradual

Desaceleracién gradual en la accién. Conocida también como desaceleracidn.

plano de situacién

Escena en la cual el espectador puede ver toda el drea en la que se esta produciendo una
secuencia. Por ejemplo, si un nifio esta jugando en el patio delantero de su casa, el plano de
situacidn serfa una escena en la que el espectador puede ver la casa, el patio, parte de la calle
y los edificios situados alrededor del punto de accién central. Esto ayuda al espectador a
entender |la ubicacién de la historia y la orientacién de la escena.

exposicién

En animacidn, una exposicién es el nimero de celdas en las que un dibujo aparece en la
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escena. Para que un dibujo aparezca mas tiempo, se debe extender durante un nimero de
celdas mayor.

carta de exposicion

Hoja con varias columnas verticales y fotogramas horizontales que se utiliza para indicar el
tiempo de una escena. Cada columna representa una capa de escena. Los ndmeros de
dibujos de cada columna se indican y se repiten a lo largo de la cantidad de fotogramas
determinada en la que deben aparecer.

La carta de exposicidn la utilizan los animadores, directores y otros miembros del equipo
para trazar la secuencia y el tiempo de las imdgenes, el didlogo, los efectos de sonido, las
pistas de sonido y los movimientos de cdmara. Conocida también como carta de rodaje.

fundido de
entrada/fundido de
salida

El fundido de entrada o fundido de salida es un efecto de transicidn utilizado para abrir o
cerrar una secuencia. Un fundido de entrada se produce cuando la primera escena aparece
progresivamente, desde una transparencia total a su opacidad total. Un fundido de salida se
produce cuando la escena desaparece progresivamente, desde la opacidad total a la
transparencia total.

aceleracién de entrada

Aceleracién drastica al principio de la accidn.

aceleracién de salida

Aceleracion drastica al final de la accidn.

campo

Unidad de medida utilizada para calcular el movimiento, el registro y la posicidn de la cdmara.
Una escena de animacién estdndar tendrd entre 6 y 12 campos.

hoja de campos

Gufa que contiene todas las unidades de campo que los artistas de animacién y layout
utilizan para determinar un tamafo de escena o movimiento de cdmara.

film-1.33 | Resolucién idénea para el formato de pelicula panordmico que se ajusta a la proporcidn
estdndar de 4:3 pixeles.
film-1.66 | Resolucién idénea para el formato de pelicula panordmico que se ajusta a la proporcion de
16:9 pixeles. (Los pixeles son mds anchos que altos).
flipping | En la animacidn tradicional, flipping es la accién de pasar por los dibujos de una secuencia

de animacién muy rdpidamente con el fin de ver la animacién en movimiento. Flipping
también puede ser la accién de crear una transformacion en espejo de un objeto.

animacion secundaria

Movimiento secundario provocado por la accidn principal. Por ejemplo, un personaje que
correy lleva puesta una capa. La accién principal es el cuerpo que corre. Esto provocara que
la capa siga el movimiento, aunque no se moverd al mismo tiempo, sino que reaccionara
varios fotogramas después y seguird la curva de movimiento principal.

cinemadtica directa

La cinemdtica directa es una funcidn utilizada para animar principalmente personajes 3D y
marionetas Cut-out con jerarquia. Se utiliza para animar una marioneta a partir de una de sus
partes padres, como un hombro, y hacer que el resto del brazo se mueva con ella como un
todo.

fotograma

Un fotograma de animacién es una imagen fotografica tGnica en una pelicula. En la animacién
tradicional, el estdndar norteamericano contiene generalmente 24 fotogramas por segundo,
mientras que el estdndar europeo es de 25.

fotogramas por segundo

Representan la velocidad a la que se reproducen los fotogramas por segundo. Se calculan
por lo general en fotogramas por segundo. Por ejemplo, una escena se podria reproducir a
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12, 24, 25, 30 o 60 fotogramas por segundo o a cualquier otro nimero.

Es la medida de la frecuencia (tasa) a la que un dispositivo de imagen produce imdgenes
consecutivas Unicas, denominadas fotogramas. El término se aplica porigual a los gréficos
por ordenador, videocdmaras, camaras de pelicula y sistemas de captura de movimiento.

La tasa de fotogramas se suele expresar principalmente en fotogramas por segundo (fps) y
en monitores de barrido progresivo en hercios (Hz).

funcién

Movimiento, trayectoria o ruta generados por ordenador al que se pueden conectar
pardmetros de elementos, otras trayectorias y efectos. La funcién se puede controlar
agregando fotogramas clave y puntos de control en la curva de funcidn.

gama

Rango de colores que puede representar un dispositivo determinado.

HDTV

Acrénimo en inglés de television de alta definicidon que ofrece una imagen de mayor calidad
que la televisidn estdndar, ya que dispone de un ndmero de lineas de resolucién superior.
Para sacar partido de la calidad superior y utilizar plenamente la configuracién de resolucién,
el dispositivo de salida debe ser compatible con la tecnologia HDTV.

hold

Fotograma en la animacidn en el cual el personaje mantiene su posicion sin moverse. Se
puede crear un hold entre dos fotogramas clave cualesquiera.

HSV

Siglas en inglés para matiz, saturacién y valor. Método para definir los colores en cuanto a
matiz (tinte), saturacién (sombra) y valor (tono o luminancia).

intercalado

Dibujos que existen entre las poses clave. Se dibujan para crear transiciones fluidas entre
poses.

ink and paint

El proceso ink and paint es la accién de pintar las zonas vacias y colorear las lineas en los
dibujos de animacidn finales siguiendo un modelo de color.

interpolacion

Movimiento generado por ordenador creado entre dos fotogramas clave. Se puede crear
interpolacidn, o no, entre los fotogramas clave.

cinematica inversa (IK)

Funcidn utilizada principalmente para animar personajes 3D y marionetas Cut-out con
jerarquia. La cinemdtica inversa animard una marioneta desde una de las extremidades, como
una mano, y permitird que el resto del cuerpo la siga con naturalidad.

corte de salto

Corte brusco entre dos escenas. Normalmente, un corte de salto no es visualmente
agradable. Normalmente lo provoca el final de una escena y el comienzo de otra, con una
imagen parecida. La falta de diferencia provoca que el 0jo vea un pequeno salto entre las dos

escenas.

pose clave

Posiciones importantes en la accién que definen los puntos inicial y final de cualquier
transicion suave. Las claves, o poses clave, son los dibujos principales de una secuencia de
animacién que describen el movimiento. Por ejemplo, si se agita un brazo, las claves
corresponderdn al brazo de una extremidad del movimiento de onda vy a la otra extremidad. Al
realizar un flipping de dichos dibujos, el animador puede ver el esqueleto del movimiento sin
tener todos los dibujos.

atajos de teclado

Una o varias teclas del teclado que, al usarlas, provocan que se realice una operacién.

fotograma clave

Posiciones importantes en la accién que definen los puntos inicial y final de cualquier
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accién. Un fotograma clave es una posicién generada por ordenador en un momento
especifico (fotograma) y en una trayectoria determinada.
capa | En animacidn, una capa es una columna, nivel o personaje individual. Las capas de una
escena estdn superpuestas para formar la imagen final.
layout | Paso de comunicacidn entre el storyboard y la animacién. Es la accién de poner el storyboard

en el modelo. Es decir, el personaje se dibuja siguiendo el disefio del paquete de modelo, de
modo que el animador puede comenzar a trabajar.

El artista de layout dibuja el fondo y crea la cdmara y la guia de campo, haciendo coincidir la
escenay el movimiento de la cdmara. Por Ultimo, el animador dibuja en el modelo las poses
de accidn principales.

layouty pose

Accién que consiste en poner el storyboard en el modelo (a la escala adecuada) para que el
animador comience a trabajar.

artista de layout

Artista que dibuja el fondo y crea la cdmara y la guia de campo, haciendo coincidir la escena
y el movimiento de la cdmara. Dibujard en el modelo las poses de accidn principales.

planificacién de layout

Dibujo de las funciones principales de la escena que se utiliza como referencia al planificar la
animacién y ejecutar sus etapas iniciales.

proceso de layout

Paso de comunicacidn entre el storyboard y la animacién.

libreria | Zona de almacenamiento que contiene plantillas y recursos que se pueden reutilizar en un
proyecto o escena.
mesa de luz | Dispositivo que permite ver otras capas en transparencia mientras trabaja en una capa

determinada.

linea de accién

Direccién que seguira la accién.

sincronizacién de labios

Proceso que consiste en sincronizar la boca de un personaje con sonidos en la pista de
sonido del didlogo. La boca se ajusta fotograma a fotograma para hacer coincidir el sonido
del didlogo y aparentar que el personaje estd hablando. La sincronizacién de labios se puede
utilizar para cualquier secuencia de sonido y no solo para el habla. Por ejemplo, puede hacer
que un pdjaro pie o que un lobo aldlle ala luna.

baja resolucién

Formato idéneo para videos destinados a la web, donde el tamafio y la descarga répida del
archivo de video tienen prioridad respecto a la calidad. Una imagen de baja resolucién es
aquella que no contiene detalles precisos.

deteccién manual de
sincronizacién de labios

Intercambio manual de dibujos de posicién de la boca para que coincidan con una pista de
voz. Para este proceso, se utilizan tanto la depuracién de sonido (escuchar una onda de
sonido descompuesta fotograma a fotograma) como las sustituciones de dibujos.

paleta maestra

Grupo de colores atribuidos a un personaje o prop. La paleta se utiliza durante toda la
produccién para mantener la coherencia en el aspecto y para garantizar que se utilicen los
mismos colores durante la produccién. Conocida también como paleta.

modelo/modelo de color

Disefio de personaje, prop o ubicacién definitivo que cada artista debe seguir para una
produccién. Un modelo de color es el disefio de color oficial que se debe utilizar para pintar
la animacidén.
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morphing

Funcién que permite crear dibujos generados por ordenador entre un dibujo de origen y otro
de destino. La animacidn creada con la funcién de morphing se puede reutilizar en distintos
proyectos.

fotograma clave de
movimiento

Fotograma clave con interpolacién generada por ordenador.

carta de fonemas

Carta basada en los ocho fonemas de la animacién (A, B, C, D, E, F, G y X, que se utiliza para
representar el silencio) utilizados para la sincronizacién de labios.

multiplano | Efecto de pasar por diversos niveles de dibujos para crear una sensaciéon de profundidad en
un plano. Un multiplano es una escena en la que las capas estdn colocadas a distintas
distancias de la cdmara, de modo que, cuando la cdmara se mueve, se produce una ilusién de
profundidad. Con un multiplano, toda la perspectiva y la escala se calculan automaticamente.
NTSC | Sistema de difusidn televisiva analégico estandar utilizado en Norteamérica. NTSC se cifie a

los estdndares norteamericanos respecto al modo en que los pixeles rectangulares se
muestran para las pantallas de ordenador y de televisidn.

desplazamiento pequeio

Pequefio empujén (izquierda, derecha, arriba, abajo, hacia delante o hacia atrds) realizado
con las teclas de flecha del teclado en un elemento seleccionado. El desplazamiento pequeno
se utiliza para mover una seleccién de manera muy ligera y precisa.

papel cebolla

Funcidén que permite ver los dibujos anterior y siguiente de una secuencia.

capa superior

Parte del entorno de una escena, como una silla o un arbusto, que se coloca delante de la
animacioén principal.

PAL

Resolucién que funciona mejor con el formato europeo para pantallas de televisién y de
ordenador, ya que los pixeles rectangulares se muestran con una orientacién distinta.

paleta/paleta maestra

Una paleta o paleta maestra es un grupo de colores atribuidos a un personaje o prop. La
paleta se utiliza durante todo el proyecto para mantener la coherencia en el aspecto y para
evitar cambios de color durante la animacién. También se le denomina paleta maestra.

estilo de paleta

Un estilo de paleta es una segunda versién de una paleta existente con un ligero cambio en
el tinte y el valor. Un estilo de paleta se puede utilizar para crear la versién nocturna de una
paleta. También se le puede denominar paleta de clonado.

panear

Mover la cdmara atravesando la escena en cualquier direccidn.

panel

En un storyboard, un panel es la vifieta en un plano. Un plano puede estar compuesto por
uno o varios paneles.

animacién sin
papel/tradigital

El proceso de animacidén sin papel es la accién de animar digitalmente. El principal proceso
de animacidn sin papel es dibujar la animacién, fotograma a fotograma, directamente en el
software.

posicién de paso

Al dibujar una secuencia en la que un personaje camina, la posicién de paso es el punto en el
que una pierna pasa a la otra.

peg

En la animacidn tradicional, es una herramienta utilizada para garantizar el registro preciso de
la accién a medida que se mueven las capas de celdas. En la animacién digital, en la que se
realiza un rigging de marionetas mds avanzado, se pueden usar capas de pegs. Las capas de
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pegs son capas de trayectoria que no contienen dibujos. Son rutas de movimiento que puede
usar para agregar articulaciones de ruta. Para las (ltimas, también puede utilizar una
herramienta de cinemdtica inversa.
fonema | Unidad de sonido de un idioma.
pivote | Punto alrededor del cual un peg o dibujo rota.
pixel | Elemento mds pequefio de unaimagen mostrado en un monitor o pantalla de televisién.

El pixel, abreviatura en inglés de elemento de imagen, es un punto Unico en unaimagen
gréfica. Es una pequefia muestra de una imagen, un punto, un cuadrado o una seccién muy
pequefa compuesta de filtrado suavizado. Si acerca el zoom lo suficiente en una imagen
digital, verd los pixeles, que parecen pequefios cuadrados de distintos colores e intensidad.

animacion pose a pose

El proceso de animacidn pose a pose es la accidn que consiste en crear todas las poses de
accién principales, denominadas poses clave, y después colocar las poses secundarias entre
las claves. Las poses secundarias se denominan descomposiciones. Por dltimo, el animador
rellena los huecos con los dibujos intercalados para lograr una animacién fluida.

renderizado

Paso final de la animacidn por ordenador. Durante el renderizado, el ordenador toma cada
pixel que aparece en la pantalla y procesa todos los componentes. Ademds, agrega
desenfoque de movimiento antes de que produzca una imagen final. Es el proceso de
calcular las imagenes finales después del proceso de composicidn.

resolucién | Tamafo de una escena, calculado por lo general en pixeles. Por ejemplo, la resolucién NTSC
es de 720 x 480. La resolucién debe coincidir con la salida final: HDTV, film-1.33, film-1.66,
NTSC, PAL, baja.
RGB | Siglas en inglés para rojo, verde y azul. Método que permite definir el color especificando las
cantidades de estos tres componentes del color.
rigging | Proceso de conectar las distintas partes de una marioneta Cut-out.

mesa de disco

Equivalente al disco/mesa de animacidn, es un dispositivo que permite rotar el espacio de
trabajo para mayor comodidad mientras se dibuja.

rotoscopia | Técnica de animacién en la que los animadores trazan un movimiento de pelicula de accién
en vivo, fotograma a fotograma, para usarlo en peliculas animadas. Es el acto de esbozar
sobre material de accidn en vivo para crear una secuencia animada.
bocetos | Es un nombre comun en una pelicula de animacién para un dibujo que se utiliza como

referencia, pero no forma parte de la imagen final. Un layout es un boceto.

Es el esbozo del esqueleto de una animacidn o disefio. Los bocetos consisten principalmente
en lineas y formas esbozadas, pero también pueden contener detalles de disefio.

Zoha segura

Zona central del fotograma de una escena que no quedara recortada por el fotograma de TV.
Como un fotograma de TV corta un margen del tamano del fotograma original, al mantener
una zona segura se garantiza que la accién principal de la escena siga siendo claramente
visible una vez que la pelicula se proyecte en televisién.

escena

Plano en una pelicula o programa. Una secuencia estd compuesta por varias escenas. Una
escena cambia a otra mediante un corte simple o por transicién.
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Glosario

Término | Definicién
guion | Texto original que contiene la informacidn de toda la pelicula o el programa. En animacidn, el
guion contiene todas las descripciones de la ubicacidn, el didlogo, el tiempo, etc. Un
proyecto comienza con un guion.
secuencia | Serie de escenas o planos que forman una parte distinta de |a historia o pelicula,
normalmente conectadas por la unién de la ubicacién o el tiempo.
plano | Escena en una pelicula o programa. Una secuencia estd compuesta por varios planos. Un

plano cambia a otro mediante un corte simple o por transicién.

aceleracién

Aceleracién gradual en la accién. Conocida también como aceleracién-gradual.

desaceleracién

Desaceleracién gradual en la accién. Conocida también como desaceleracién-gradual.

slugging

Indicacidn de los tiempos de inicio y detencién de un didlogo y las acciones relevantes.

depuracién de sonido

Proceso que permite escuchar el sonido en tiempo real, mientras mueve el cabezal de
reproduccién hacia delante o hacia atrds. Es muy (til para realizar el ajuste preciso de una
sincronizacién de labios.

fotograma clave de
Stop-motion

Fotograma clave sin interpolacién generada por ordenador.

storyboard

Plan visual de todas las escenas y planos de una animacidn. El storyboard indica lo que
sucederd, cudndo lo hard y cémo se distribuyen los objetos en una escena.

directa animacion

Técnica en la cual se dibuja por orden una secuencia completa desde la primera posicién
hasta la dltima. Esta metodologia requiere muy poca planificacion. El lugar en el que el
personaje terminay cémo llega hasta alli pueden ser una sorpresa tanto para el publico como
para el animador. Este enfoque es espontdneo y creativo, pero puede generar resultados
imprecisos.

lineas vectoriales

Lineas vectoriales invisibles que forman las zonas de dibujo. Se pueden ajustar mediante

transparentes | controladores de curvas Bézier.

simbolo | Unicono combina animacidn, ilustracién o capas en un Unico objeto que puede controlar en
una capa. También puede crear iconos de cada parte del cuerpo en marionetas Cut-out.
En unicono puede colocar lo que desee. Puede utilizar simbolos para animar una marioneta
o crear animaciones reutilizables, como un parpadeo.

tableta/ldpiz | Dispositivo utilizado junto con un ratén, o en lugar del mismo, para mover el puntero (en

ocasiones denominado cursor) por la pantalla del ordenador.

plantilla | Recurso almacenado en la libreria que se puede reutilizar en cualquier proyecto. Una plantilla

puede ser un dibujo, una serie de fotogramas clave, un archivo de sonido, un panel, un
personaje Cut-out, un efecto, una trayectoria, una animacién o cualquier otra cosa que se

utilice en la animacidn.

imagen en miniatura

Imagen muy pequena utilizada como una referencia o indicador.

cédigo de tiempo

Informacién de tiempo impresa en un clip de pelicula para indicar la escena, hora, minuto y
segundo que se muestran actualmente en pantalla.

linea de tiempo

Representacion horizontal de los elementos, el tiempo y los fotogramas clave de una escena.
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Término

Definicién

trazar y pintar

Una vez que los bocetos de las animaciones se han limpiado y se ha realizado una prueba de
Ifnea o de Idpiz final, cada dibujo se traza y se pinta para la animacidn final. En el mundo
digital actual, esto se puede realizar de maneras distintas a los métodos de celuloide o
acetato tradicionales.

desglose de pista de
audio

Desglose de una pista de pelicula animada en sonidos individuales para generar la posicién
fotograma a fotograma precisa de cada sonido.

animacidn tradicional

Tipo de proceso de animacién mediante el cual todas las secuencias de animacidn se dibujan
a mano en papel antes de digitalizarlos o tintarlos en celdas.

trayectoria

Ruta o trayectoria generada por ordenador que pueden seguir los elementos. La trayectoria
se puede controlar mediante puntos de control, fotogramas clave y velocidad.

transicién

Efecto colocado entre dos escenas cuando se pasa de una a otra. Efectos de transicidn
comunes son el fundido encadenado y el barrido.

capa de fondo

En animacién, una capa de fondo es una parte especifica de |la decoracién colocada detrds de
la animacidn principal.

vector

Una imagen basada en vectores estd compuesta por puntos y curvas Bézier. El ordenador lee
los puntos y traza los segmentos, vinculdndolos para reproducir la forma de imagen. Una
imagen vectorial no contiene tamafio fijo ni resolucidn. El gréfico se puede ampliar y
distorsionar segin se desee y el sistema volverd a calcular los segmentos y reconstruird las
formas. Las imdgenes vectoriales se trasladan y se muestran en pixeles una vez que el célculo
se ha realizado.

velocidad

En animacidn, la velocidad es la aceleracion o la desaceleracion de un movimiento. Se puede
alcanzar mediante una curva de funcién o una serie de dibujos animados. Otros términos
comunes para aceleracién-gradual y desaceleracién-gradual son aceleracién y
desaceleracion.

ciclo de andar

Animacién que representa a un personaje mientras camina en su posicién. La ilusién de
movimiento se crea utilizando paneos de fondo. A fin de evitar animar a un personaje que
camine unay otra vez en cada episodio de una serie, es habitual preparar ciclos de andar para
cada personaje en una produccidn, de modo que se pueden reutilizar segln sea necesario.

Zona

Area que se puede pintar con color.
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